
NeoProfil

Almaya, bukan
alkisah, adalah

sebuah dunia tak berbatas. Dunia maha
luas di jagad maya. Dunia dengan pen-
duduk dari tujuh penjuru angin. Almaya,
itulah Active Worlds. Dunia yang akan
membuat penduduknya menjadi Citizen
of ‘the’ World. Bergabunglah dengan
ratusan ribu pemaya lain yang menik-
mati kebebasan hidup di Active Worlds.
Datanglah ke www.activeworlds.com
dan mendaftarlah menjadi penduduk
dengan biaya ‘hanya’ US$19.95.

Citizen of ‘the’ WCitizen of ‘the’ Worldorld

Sebagai penduduk
anda berhak mengklaim wilayah dan

membangun di atas ‘tanah’ anda. Anda boleh membangun
apa saja yang anda inginkan. Rumah yang menyenangkan di
pedesaan, kapal ruang angkasa, gedung perkantoran. Anda
dapat membangun kota anda sendiri. Pokoknya apa yang
dapat anda bayangkan dapat dibangun di Active Worlds
dengan kemungkinan
tidak terbatas!

AlmaAlmaya...ya...

PPembangunan... :)embangunan... :)

Avatar adalah
representasi anda

di Active Worlds. Avatar dapat berlari, melompat,
terbang, menari, bahkan menunjukkan emosi. Anda dapat me-
miih satu dari ribuan model yang ada. Anda dapat menggu-

nakan avatar untuk bermain, mulai
dari sepak bola, boling, hockey,
catur... semua game. Anda dapat
berceloteh dengan penduduk dari
seluruh penjuru dunia di ruang chat,
24 jam sehari, 7 hari seminggu. Dan
bagi yang shopping mania, silakan
berkunjung ke mal-mal maya.

Menikmati hidup...
Menikmati hidup...
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Pendamping Berselancar Salam!Salam!

a! Untuk melengkapi kiprah NeoTek di arena
edukasi pengguna Internet di tanah air ini, kami
menyediakan CD. Seperti pernah kami katakan,

inilah upaya kami untuk membantu agar anda tidak perlu
men-download program-program yang dibahas di NeoTek.
Penyebarannya pun tidak kami paksakan. CD tidak kami
bundel langsung dengan NeoTek agar anda yang tidak
berniat membeli CD tidak usah terpaksa merogoh kantung
lebih dalam. Konsekuensinya, hanya ada 1.000 majalah
yang kami edarkan disertai CD. Dan untuk sementara
hanya kami sebarkan di kota-kota besar.

Redaksi
rreeddaakkssii@@nneeootteekk..ccoo..iidd

NeoTNeoTek memberi edukasi, bukanek memberi edukasi, bukan
animasi. Itu yang anda dapatkananimasi. Itu yang anda dapatkan

di dalam CD.di dalam CD.

YY

• Cepat dapatkan CD NeoTek! Selain berisi program hasil download, CD kami juga
berisi program lain yang bermanfaat untuk anda dalam ber-Internet.

Bagaimana menghubungi NNEEOOTEK?TEK?
KONTRIBUSI ARTIKEL
redaksi@neotek.co.id

SURAT PEMBACA
support@neotek.co.id

WEBMASTER
webmaster@neotek.co.id

PEMASARAN
pemasaran@neotek.co.id

ADMINISTRASI IKLAN
Tel. 021-5481457 Fax. 021-5329041

SIRKULASI NEOTEK
Tel. 021-3854764

ALAMAT REDAKSI
Gedung Cahaya Palmerah Suite 503
Jl. Palmerah Utara III No. 9
Jakarta 11480

NeoTek menyediakan CD
yang berisi program-
program yang dibahas
pada NeoTek nomor ini:

• Personal Web Server
• Apache for Windows
• Xitami dan Sambar
• vWebServer
• MySQL for Windows
• PHPTriad
• PHPEd
• PHP Easy Windows Inst.
• ASPEdit
• NScan 0.9
• Traceroute
• Snort
• ZoneAlarm
• ZOC Terminal Emulator

+ utilitas berguna lainnya
seperti NAV2001, NU 2001,
RegClean, dan CyberSitter.

Dapatkan CD-ROM-nya
dalam satu paket dengan
majalah NeoTek:

Majalah + CD Rp19.500
CD saja Rp15.000

Hubungi
Bagian Sirkulasi
Majalah NeoTek
Tel.   (021) 548 1457
Faks. (021) 532 9041

email:
pemasaran@neotek.co.id
Kontak: Elvi R. Nainggolan

MILIS PARA NEOTEKER
http://groups.yahoo.com/group/majalahneotek

www.neotek.co.id

Dapatkan juga bundel Neotek

Bundel I: NeoTek Vol. I, No. 1-6

Bundel II: NeoTek Vol. I, No. 7-12

Rp59.000
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Daftar Isi

Daftar IsiDaftar Isi
NeoStartNeoStart

NeoTNeoTek Vek Vol. Iol. I I No. 3I No. 3
NeoTNeoTutorutor

NeoTNeoTeknoekno

Hotline Redaksi
Dengan HumanClick anda
dapat chat langsung dengan

redaksi NeoTek. Semakin interaktif!

7 Dynamic HTML
Memahami Cascading Style
Sheet (CSS).

16

Registry pada IE
Rahasia tersembunyi IE dapat
dibongkar dengan mengenali

sistem registrinya.

Telnet dan Upload
Gunakan ZOC Terminal Emu-
lator 4.0.3 untuk melakukan

telnet dan upload maupun download.

10

15

Sites2C
Bookmark anda kewalahan
menampung link-link yang

menarik? Sites2C solusinya!

8

Mengintai Jaringan
Proses final foot printing; dikenal
sebagai network reconnaisance.

42

Interogasi DNS
Mesin apa yang dipakai di
domain sasaran?

41

Network Enumeration
Kenali siapa sasaran kita
dengan fasilitas Whois terhadap

domain, point of contact, dan name server.

40

Foot Printing
Intelijen adalah langkah
pertama dalam hacking.

PHPEd
Bukan sekedar editor, PHPEd
mempunyai fasilitas server

untuk menguji script anda.

30

Class & Ext. Style Sheet
Praktek langsung Class dan
External Style Sheet pada ha-

laman Web anda.

Dynamic HTML
Memahami Server dan Server-
side Scripting

PWS & PHP pada PWS
Instalasi server IIS mini dari
Microsoft ini dan selain ASP,

PHP dapat dijalankan pada server ini.

PHPTriad
Instal Apache, PHP, dan MySQL
sekaligus pada Windows anda.

20

22

24

28

Situs NeoTek www.neotek.co.id
neotek.kpone.com.sg

Jadikan situs NeoTek sebagai pangkalan Anda berselancar

Link Langsung
Kunjungi situs-situs yang dibahas di
majalah NeoTek dengan sekali klik
lewat situs NeoTek.

NeoTek versi PDF
Kehabisan NeoTek di kota Anda?
Dapatkan saja versi PDF-nya. Gratis!

Download
Tersedia juga download di situs
NeoTek selain dari situs aslinya

Layanan Rupa-rupa NeoTek
Dapatkan perlengkapan awal dalam
berinternet dari situs web NeoTek
HumanClick
Hotline langsung ke redaksi NeoTek
untuk menyampaikan saran dan pesan.
Chat Room
Kini tidak usah jauh-jauh untuk ngobrol
langsung dengan sesama NeoTeker
Mailing List
Ini yang paling ramai. Segera ikutan
berbagi pengalaman berinternet!

38



NeoTNeoTeknoekno

NeoSearNeoSearchch

Menyetel Mandrake 8.0
Kenali parameter-parameter
Linux sambil menyetel sistem

operasi Linux anda yang baru ini.
Penyetelan ini mencakup juga penye-
telan LAN dan akses internet.

36

Menginstal Linux
Linux kini semakin digemari
saja.  Kenali Linux mulai dari

mengenal langkah-langkah instalasinya.

32

Instalasi Mandrake 8.0
Mandrake adalah salah satu
flavour Linux yang paling po-

puler dan mudah digunakan. Kemam-
puannya mendeteksi periferal memu-
dahkan instalasi.

34

Copernic 2001
‘Monster’ dari segala mesin
pencari yang mampu mencari

informasi sekaligus di 80 search engine.
Nyaris tidak ada informasi yang terle-
watkan dalam riset anda.

48

Menyiapkan Partisi
Siapkan lokasi untuk Linux
sambil tetap mempertahankan

Windows anda. Untuk itu gunakan
Partition Magic.

FlashGet
Percepat download dengan
‘membagi-bagi’ file dan men-

download bagian-bagiannya secara
simultan dengan FlashGet

Morpheus
Morpheus sempat menjadi top
download selama beberapa

minggu terakhir ini mengingat kemam-
puannya untuk mencari dan men-
download file dengan teknologi P2P.

33

44

46

Daftar Isi

NeoProfil

RealProfil

NeoTek Januari 2002

‘Unix’ pada Windows
Cygwin dapat diinstalasi pada
Windows dan membawa ‘look and
feel’ Unix pada Windows anda. 

JavaScript dalam DHTML
Apa saja yang dapat dilakukan oleh
JavaScript untuk membuat situs
yang dinamis ini?

SWiSH 
Kali ini kita bahas SWiSH 2.0. Lebih
canggih tetapi tetap mudah dalam
membuat file yang Flash compatible.

Active World0

Kru NeoTek
Bermarkas di
Gedung Cahaya Palmerah 503
Jl. Palmerah Utara III No. 9
Jakarta 11480
Telp. 021-5481457
Fax. 021-5329041

Bank
Bank BNI
a.n. PT NeoTek Maju Mandiri
No. rekening 070.001709720.001

Bank BCA KCP Rawamangun
a.n. Aswan Bakri
No. rekening 0940544131

Pemimpin Umum
Fachri Said

Pemimpin Redaksi
Kosasih Iskandarsjah

Redaktur Ahli
Onno W. Purbo
Michael S. Sunggiardi

Pemimpin Usaha
Fahmi Oemar
Ridwan Fachri

Redaktur Pelaksana
Gianto Widianto
Dadi Pakar

Sekretaris Redaksi
Elvy Risma Nainggolan

Dewan Redaksi
Supriyanto
Ma’mun Abdul Malik

Pemasaran
Hedhi Sabaruddin
Andy Yudiantoro
Tuti Sundari

Sirkulasi
Deddy Ardiansyah
Bangun
M. Ismail

Keuangan
Aswan Bakri
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FOKUS BULAN INIFOKUS BULAN INI
Masuki dunia maya
yang lengkap dengan
kehidupan dan fasilitas
virtualnya.

NmN
Neoteker menjawab Neoteker
dalam forum milis NeoTek

Ada Apa di CD NeoTek?
Server dan Scripting Tools
Hacking Tools
Allyo Guide
StuffIt

Daftar Isi CD NeoTek
WordWeb
Netscan Tools
Program Umum Berselancar
Program Berguna Lainnya

NeoRagam

Inbox

Linux MandrakeLinux Mandrake
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NeoRagam

AdaAda ApaApa didi CCDD NeoTNeoTek?ek?
CD NeoTek bulan ini terutama memuat berbagai jenis server yang dapat
anda praktikkan untuk memahami server dan server-side scripting yang
menjadi salah satu topik bahasan bulan ini selain Linux.

CCDD  NNeeooTTeekk
DDeesseemmbbeerr  22000011

ulai Desember
2001 (Vol II No.
3), NeoTek seca-

ra terbatas mendistribu-
sikan majalah bersama
CD NeoTek.

CD NeoTek pada dasarnya
adalah kelanjutan dari la-
yanan CD download untuk
software yang dibahas
dalam majalah NeoTek
ditambah dengan software-
software lain yang dipan-
dang perlu untuk memu-
dahkan anda memprak-
tikkan bahasan-bahasan
dalam majalah.

Majalah NeoTek sendiri
dengan demikian akan
didistribukan dalam dua
kemasan: tanpa CD dan
dengan CD. Harga majalah
tanpa CD tetap Rp9.500,-
sedangkan yang dengan CD
Rp19.500,-

Anda dapat memilih mana
yang paling sesuai dengan
anda. Bila anda lebih suka
membeli majalah tanpa
CD, maka anda masih tetap
dapat men-download soft-
ware yang dibahas dari
Internet.

Majalah dengan CD dapat
dipetroleh di toko-toko
buku Gramedia atau lang-
sung ke kantor NeoTek di
Jakarta.

!Personal Web Server
Server mini dari Microsoft.
Cocok untuk membuat dan
menguji fasilitas form dan
database pada FrontPage, script
ASP, dan juga script PHP.
!Apache for Windows
Server yang paling banyak
dipakai di Internet (khusus-
nya dalam Unix) kini terse-
dia pula untuk Windows.
!Xitami
!Sambar
Keduanya server kecil pada
Windows yang mendukung
PHP ataupun scripting lain.
!vWebServer
Server freeware yang men-
dukung ASP script dan
Access.

!PHPTriad
Sekaligus menginstalasi
Apache server, PHP
MyAdmin, dan MySQL
pada Windows.
!PHPEd
Editor untuk scripting yang
juga mempunyai server kecil
menguji script yang anda buat.
!ASPEdit
Editor untuk ASP maupun
Perl/CGI, PHP, dan VBScript.
!PHP Easy Windows
Installer PHP yang dapat
diinstalasi baik pada PWS,
Xitami, maupun Sambar.
!Active Perl Interpreter
Scripting tool paling populer
untuk CGI kini tersedia pula
untuk Windows.

!MySQL
Database yang umum dipa-
kai bersama dengan Apache
server yang kini tersedia
pula pada Windows.
!Miracle C Compiler
Compiler untuk C, bahasa
terpopuler kedua untuk CGI.

!AATools
Tools untuk sistem admin-
istrator: port scanner, proxy
analyzer, CGI analyzer, e-mail
verifier, whois, network status,
links analyzer, system info,
process info, resource
viewer, dan registry cleaner.

Scope Aktivitas
!Atelier Port Scanner
!NMap
!Yet Another Port Scanner
!NetCat
!WebCopier 2.7a
!Teleport Pro 1.2

Network Enumeration
!Whois 0.3
!Whois for 95/98/NT
!NSQuery

Interogasi DNS
!NSLookup
!Advanced dig 0.4

Network Reconnaissance
!Traceroute 0.2
!Nscan 0.9

Security Tools
!Snort 1.7
!ZoneAlarm 2.6

Trojan Horse
!Back Orifice

Telnet & SSH Client
!ZOC Terminal Emulator
!CRT 3.4
!PuTTY Telnet & SSH Client

Create Exploit 
!Active Perl Interpreter
!Miracle C Compiler

MM

SSEERVRVEER DR DAN SAN SCCRRIIPTPTIINNG TG TOOOOLLSS

HAHACCKKIINNG TG TOOOOLLSS
!Allyo Guide
www.allyoguide.com

Jika ingin mendapatkan link
yang relevan dengan situs
yang anda cari, anda dapat
menggunakan Allyo Guide.
Program sederhana dan gra-
tis ini akan bertengger di
browser anda. Begitu anda
mengunjungi satu situs ter-
tentu, Allyo Guide akan
mencarikan anda situs-situs
lain yang relevan dengan si-
tus yang anda kunjungi itu.

!StuffIt
www.stuffit.com

StuffIt diharapkan dapat
menyederhanakan pekerjaan
anda. Sebagai utilitas untuk
urusan pemadatan dan peng-
uraian file, StuffIt dikatakan
dapat membuka file hasil
kompresi dengan berbagai
format: StuffIt (SIT), ZIP,
gzip (GZ), bzip (BZ), LLA,
ARC, ARJ, uuencode (UUE),
Binhex (HQX), Macbinary
(BIN), dan MIME/Base64
archives.
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daftar isi cd neotekdaftar isi cd neotek
!WordWeb
www.wordweb.co.uk/free
Barangkali inilah program
kamus dan tesaurus gratisan
terlengkap. WordWeb Pro
memang anda harus bayar—
‘hanya’ US$18—tetapi anda
bisa mendapat versi gratisnya
lewat situsnya.
Jika men-download versi
gratisnya, anda tidak akan
mendapatkan fitur word list,
search, anagram dan
customization. Tetapi anda
masih memperoleh fitur definitions dan synonims, proper
nouns, related words, dan link ke MS Word.

!Netscan Tools
www.netscantools.com/ nstpromain.html

Program NetScan Tools adalah
kumpulan dari beberapa fungsi
yang terdapat pada Unix yang
kemudian di-’ekspor’ ke
lingkungan Windows. Piranti
bantu ini mendukung beberapa
queries, termasuk name server
look-up, finger, Ping, trace-
route, Whois, day/time, dan
quote. Program ini juga
mendukung informasi, layan-
an,dan protokol WinSock.

Versi 4.22 mendukung fitur klik tombol kanan mouse
dengan berbagai opsi untuk tab NetScanner, disertai be-
berapa perbaikan minor dan pembetulan bug.

Hlm.Nama FileNama Program

AATools
Active Perl Interpreter
Advanced DIG 0.4
Allyo Guide
Apache for Windows
ASPEdit
Atelier Web Port Scanner
Back Orifice (BO)
Copernic 2001
CRT 3.4
ePrompter
FlashGet 0.96a
FlashGet langpak
Microsoft Intstaller (MSI)
Miracle C Compiler
Morpheus
MySQL
Netcat 1.1 NT
Netcat Beta for Win 95, 98
Netscan Tools
Nmap
Nscan 0.9
NSLookup for Win95 & NT
NSQuerry
Partition Magic 4.01
Personal Web Server
PHPEasy Windows Installer
PHPEdit
PHPTriad
Putty
Sambar
Sites2c
Snort 1.7
StuffIt
Teleport Pro 1.2
Traceroute 0.2
vWebServer
WebCopier 2.7a
Whois 0.3
Whois for 95, 98, NT
Win95 Wsock Upgr./Apache
WordWeb
Xitami
Yet Another Port Scanner
ZOC Terminal Emulator
ZoneAlarm 2.6

aat4xx
activeperl5.6.1
dig04
allyoguide
apache_1.3.22
aspedit
awsps46
bo
copernic2001basic
ntcrt34
epsetup
fgf096a
langpak
instmsi
mc32shr
morpheus-b3d-v2
mysql3.23.42
nc11nt
ncnt090
nst32242
nmapnt
nscan09
nslookup
nsquerry
pm401de
ws2setup
php404
phpedsetup3x
phptriadsetup2-11
putty
sambar50
sites2c10
snort1.7-win
stuffit7
pro12
tracert02
vweb111
webcopier
whois03
whoisi
w95ws2setup
wordweb
bw3224d9
yaps
zoc43_win_english
zonealm26zl

38
23
41
4

22
23
4
5

48
15
5

44
44
5
4

46
23
4
5
5
4

38
40
41
33
24
26
30
28
4

22
6

43
4

39
42
41
39
40
40
22
5

22
4

15
43

PPrrooggrraamm  BBeerrgguunnaa  LLaaiinnnnyyaaPPrrooggrraamm  BBeerrgguunnaa  LLaaiinnnnyyaa

PPrrooggrraamm  UUmmuumm  BBeerrsseellaannccaarrPPrrooggrraamm  UUmmuumm  BBeerrsseellaannccaarr
Internet Explorer 6.0
Netscape Navigator 6.1
Netscape Communicator 4.78
Opera 5.12
Real Player 8 Basic
Quick Time
Windows Media Player 7.1
Adobe Acrobat Reader
Macromedia Flash Player
Macromedia Shockwave
Winzip 8.1

PC Cillin Antivirus
Cute FTP
WS_FTP
ICQ 2000a Beta
mIRC
Visual IRC
Go!Zilla
WinAmp 2.75
IrfanView
ACDSee
Eudora 5.1

!Norton Antivirus 2001
Lindungi komputer anda
dari virus maupun trojan
dengan salah satu antivirus
yang ada saat ini. Program
dan virus definition sebesar
44,8 Megabyte 

!Norton Utilities 2001
Tidak selamanya komputer
anda kerjanya mulus. Pada
saat-saat komputer ngadat,
dapatkan Norton Utilities
untuk memperbaiki disket
atau hard disk yang corrupt.
paket program trouble-
shooting klasik sebesar 86
Megabyte.

!RegClean
Sudah terlaku sering install
dan uninstall software?
Komputer akan terasa
lambat karena banyaknya
sisa-sisa informasi tentang
program yang terdahulu di
registry anda. Besrihkan
dengan RegClean.

!CyberSitter
Surfing aman di Internet
untuk sekeluarga? Gunakan
CyberSitter untuk memblokir
situs-situs yang merugikan
pendidikan.

!Desktop X
Bosan dengan tampilan
desktop yang begitu-begitu
saja? Gunakan Desktop X
untuk menambahkan true
object pada desktop Windows
anda sehingga menjadi unik.
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Inbox

Forum ini dimaksudkan sebagai bentuk offline dari mailing list
NeoTek di http://groups.yahoo.com/group/majalahneotek.

NmNNmN
NeoTNeoTeker menjawab NeoTeker menjawab NeoTekereker

Voice chat
T: Posted October 3
Di Warnet saya baru saja
download sofware “Yahoo
Messenger” terus saya co-
ba untuk chat voice kok
tidak bisa dan muncul pe-
san “Yahoo! Messenger:
You cannot use voice in
this conversation as you
are behind a irewall.
(10/2/01 at 12:39 PM).”
Dan yang bisa untuk chat
voice hanya komputer di
mana terpasang modem.
Bagaimana caranya agar di
workstation yang ada dapat
untuk chat voice? Di work-
station kami sudah terpa-
sang soundcard dan juga
headset.
Agung Swandharu
swandharu@yahoo.com

J: Posted October 10
Untuk komunikasi di Inter-
net program akan menggu-
nakan port-port tertentu.
Contoh web pakai port 80
pop mail pakai port 110
smtp mail pakai port 25.

Kalau anda berada di bela-
kang proxy di warnet maka
biasanya hanya sedikit port
yang terbuka ke Interrnet.

Konsekuensinya hanya port
yang terbuka yang bisa ko-
munikasi. Seperti web, mail
dan chatting biasanya di-
buka oleh proxy warnet
dengan konsekuensi port
yang tertutup ya akan mati
aja, termasuk voice chatting
di Yahoo Messanger itu.
Onno W. Purbo
onno@indo.net.id

ASP
T: Posted October 3
ASP itu apa?
Fikri
fikri_ardi@telkom.net

J: Posted October 9
ASP itu Active Server Pages,
sebuah bahasa scripting
yang digunakan untuk
membuat aplikasi-aplikasi
Web dengan sifat server
side, artinya  script ASP ini
akan dieksekusi di server
dan dikirimkan ke browser
dalam format HTML biasa.

Ya, memang semacam PHP.
Yang membedakan ASP ba-
hasanya mirip bahasa Ing-
gris biasa jadi lebih mudah
dipahami, namun bikin ma-
les nulisnya krena biasanya
panjang-panjang.

roswatis@yahoo.com

mySQL
T: Posted October 4
Apa sih yang dimaksud de-
ngan software database
mySQL itu. Apakah untuk
mengelola database di Web-
site. Ada informasi lengkap
tentang software ini nggak?

EPHI VAN LIN
ephi_vl@yahoo.com

J: Posted October 4
MySQL & Postgresql ada-
lah database di UNIX/
Linux. Bisa dipakai untuk

di belakang Web, bisa juga
sendiri.
2-2-nya biasanya ada ber-
sama distribusi Linux, pa-
ling engga di distribusi
Mandrake 8.0 yang saya
pakai ada, termasuk
manual-nya. Bisa di baca di
bagian documentation di
Linux. Biasanya ada di
start > documentation >
howto.
Harusnya majalah NeoTek
yang akan datang (Vol II,
No 3, Desember 2001, Red.)
akan ada artikel tentang
bagaimana menginstalasi
Linux Mandrake, termasuk
supaya dual boot di satu
PC.
Belum dibuat artikel utk
main database-nya :) ...

Onno W. Purbo
onno@indo.net.id

Artikel Linux
T: Posted July 30
Saya pengen usul kalo
Neotek juga nambahin
artikel tentang Sistem
Operasi LINUX.

Community20=te
bizzcomtech@yahoo.com.au

KomentarKomentar

• Bagi yang ingin mengetahui tentang ASP, LLeeaarrnnAASSPP (wwwwww..lleeaarrnnaasspp..
ccoomm//lleeaarrnn) cukup komprehensif membeberkan seluk beluk ASP. Ada
bagian pelajaran (lessons) yang bersifat new, changed, dan beginners.

Gimana cara kita memanfa-
atkan Internet untuk mem-
peroleh pekerjaan baru atau
pekerjaan yang lebih baik?
Mau tau? baca aja lebih
lanjut. Ini pengalaman
pribadi looooo....

1. Gunakan web untuk men-
dapatkan info perkiraan stan-
dar gaji. Cari data survei
perdagangan dan publikasi
online. Kemudian kirimkan
resume kerja. Hubungi
orang-orang yang terlibat
dengan pekerjaan yang anda
inginkan secara online.

2. Buatlah website yang
menggambarkan kemam-
puan anda. Ini adalah satu
cara efektif untuk menun-
jukkan pengalaman anda
secara nyata. 

3. Buat salinan resume an-
da secara elektronik. Ini ca-
ra sederhana yang bisa an-
da lakukan. 

4. Cari informasi mengenai
perusahaan menarik. Dapat-
kan keterangan tentang apa
yang mereka jual, kepada
siapa, bagaimana keadaan
keuangannya, juga berita
terbarunya. Lihat juga press
realease mereka untuk me-
ngetahui strategi bisnisnya.  

5. Bergabunglah dengan
kelompok-kelompok diskusi
untuk mempertajam penge-
tahuan teknis anda. 

6. Bila anda seorang pro-
grammer, tingkatkan juga
kemampuan komunikasi. 

7. Lanjutkan pendidikan
anda. 

8. Jelajahi Internet. Dari sini
anda dapat mencari
informasi dalam bidang
anda

9. Lakukan kerja praktek
atau magang di perusahaan
dimana anda ingin bekerja. 

10. Wujudkan impian anda.
Dunia kerjadewasa ini
menuntut antusiasme yang
tinggi.

Foryanto J. Wiguna
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3 PERMINTAAN DIKABULKAN
Bila permintaan anda untuk
berbincang dipenuhi, di jendela
HumanClick akan muncul pesan
yang memberitahukan hal itu.

nda cukup masuk ke situs NeoTek
pada alamat www.neotek.co.id.
Selain chat room dan mailing list,

fasilitas lain yang disediakan di situs itu
adalah sarana untuk menghubungi
redaksi secara langsung yaitu HumanClick.

Klik menu HumanClick dan di kantornya
redaksi NeoTek akan mendengar bunyi bel
yang menandakan ada seseorang yang
ingin berbincang langsung. Jika permin-
taan untuk berbincang disetujui redaksi,
maka anda pun dapat langsung berkomu-
nikasi, mirip seperti chat.

Untuk sementara, ‘jam bicara’ redaksi
masih terbatas yaitu baru bisa mulai
pukul 18.00, setiap hari kerja.

HHUUMANMANCCLILICCKK
HHOOTTLILINNE-NE-NYYA A 
RREEDDAKSAKSI NI NEEOOTTEEKK
Jika ingin berbincang langsung dengan Redaksi NeoTek,
anda dapat menghubunginya langsung lewat HumanClik.
Fasilitas ini disediakan di situs NeoTek agar anda dapat
berbincang langsung dengan redaksi lewat chat.

A

RESPONS REDAKSI
Pesan atau respons pertama yang
dikirimkan Redaksi muncul di
jendela HumanClick anda, dengan
didahului frasa
‘redaksi_neotek(singapore):’.
Komunikasi dua arah pun dimulai. 

KETIK PESAN ANDA
Ketik pesan atau pertanyaan anda
pada kotak kosong di bagian
bawah. Setelah selesai tekan
tombol ‘Enter’ atau klik menu
‘Send.’

MASUK KE SITUS NEOTEK
Arahkan browser anda ke situs
NeoTek di www.neotek.co.id atau
neotek.kpone.com.sg. Lalu cari
dan klik  Menu HumanClick di
kolom kiri halaman awal.

JENDELA HUMANCLICK
Selanjutnya muncul jendela
HumanClick yang meminta anda me-
nunggu respons dari Redaksi NeoTek.
Fasilitas ini menjadi semacam Layanan
Pelanggan (Customer Service) bagi
pembaca NeoTek.

1

4 5

2

Halo Redaksi...

PESAN ANDA PUN MUNCUL
Setelah anda menekan ‘Enter,’
pesan anda akan muncul di
jendela HumanClik dengan
didahului kata ‘you:’. Demikian
seterusnya komunikasi dapat anda
jalin dengan Redaksi NeoTek.

6
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ites2C adalah sebuah pro-
gram sederhana namun
cukup besar gunanya.

Program yang besarnya hanya 660
Kb ini dapat anda download dari
situsnya di alamat www.billy.co.il/
sites2c.

Program kecil ini dapat anda guna-
kan untuk menyimpan alamat-ala-
mat URL dari situs yang anda ang-
gap perlu anda kunjungi. Sites2C
akan anda rasakan manfaatnya
ketika suatu ketika, saat berselancar
di Internet, anda menjumpai link
yang menarik bagi anda, tetapi saat
itu anda mungkin merasa tidak

SSITES2CITES2C
MMEENABNABUUNNG KG KIINNI UI UNNTTUUKK
DDIILILIHAHAT NANT NANTTII
Suatu saat anda menjumpai link situs yang menarik tetapi belum
sempat untuk melihatnya. Simpan link situs itu dengan Sites2C
untuk anda lihat di kemudian hari.

S

MEMASUKKAN LINK
Anda dapat memasukkan link dengan cara meletakkan
kursor di atas link bersangkutan, lalu mengklik tombol
kanan mouse dan menahannya. Selanjutnya silakan ge-
ser mouse anda ke atas bidang kosong pada Sites2C,
lalu lepaskan tekanan jari anda pada tombol kanan
mouse. Dan, hopla!, link pun tersimpan di Sites2C.

TABUNGAN LINK ANDA
Inilah tabungan link anda di Sites2C. Pada sisi kanan
terlihat tanggal link itu ‘disentuh’ (Touched) oleh mouse
dan tanggal kadaluwarsa (Expires)-nya. Kedua link masih
berstatus baru (New) karena belum diakses atau dikun-
jungi. Untuk mengunjungi situs yang telah disimpan
linknya itu, anda cukup mengklikkan mouse dua kali di
atas link bersangkutan.

MEN-DOWNLOAD SITES2C
Anda dapat memperoleh gratis file instalasi Sites2C
yang besarnya hanya 660 Kb dari situsnya
(www.billy.co.il/sites2c.) Setelah men-download, an-
da akanmemperoleh sebuah file, Sites2C10.exe. Instal
Sites2C dengan mengklik dua kali file instalasi ini di
tempat anda menyimpannya di hard disk anda.

‘CELENGAN’ LINK SITUS
Setelah menginstal Sites2C anda dapat mengaksesnya
dari menu ‘Start > Programs > Sites2c.’ Program akan
dibuka seperti tampak pada gambar di atas dan siap
menjadi ‘celengan’ bagi link-link situs yang anda belum
sempat kunjungi dan berniat anda kunjungi belakangan.

1

5 6

2

Menyimpan link situs dengan Sites2C
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MEMPERKECIL BROWSER
Untuk mulai memasukkan link ke Sites2C, pertama
anda harus memperkecil browser anda dengan
menekan tombol pemerkecil di browser. Besar layar
browser anda sebaiknya hanya menguasai sekitar
setengah layar monitor agar anda dapat menempatkan-
nya berdampingan dengan Sites2C seperti pada
Langkah 4.

SIAP BEKERJA SAMA
Gambar di atas memperlihatkan posisi yang baik untuk
mulai memasukkan link-link yang anda perlu ‘tabung’ di
Sites2C.

3

PENAMBAHAN MANUAL
Anda pun dapat melakukan penambahan link secara
manual yaitu lewat menu ‘Link > New Link.’ Lalu
ketikkan alamat (URL) dari situs yang anda perlu
simpan link-nya tersebut.

7 PENAMBAHAN CARA KETIGA
Selain kedua cara di atas, link juga dapat anda masuk-
kan ke Sites2C dengan cara menggeret ikon suatu
alamat situs yang ada pada ‘Address Bar’ ke Sites2C
dengan cara yang sama dengan yang anda lakukan
pada Langkah 5.

8

4

punya cukup waktu atau tengah
mencari sesuatu yang lain.

Agar di kemudian hari dapat me-
ngunjungi situs yang anda lewatkan
itu, anda dapat menggunakan Sites2C
untuk menyimpan link bersangkut-
an. Caranya sederhana yaitu dengan
mengklik link tersebut dengan tom-
bol kanan mouse lalu menggeretnya
untuk dimasukkan ke Sites2C. Link
itu pun tersimpan dengan catatan-
catatan tertentu, seperti kapan link
itu disimpan dan kapan kadaluwarsa.

Jika Sites2C diperkecil (minimized),
maka program ini akan bertengger di
bar pada bagian kanan bawah

monitor (di sebelah penunjuk jam).
Agar Sites2C dapat menerima drag
and drop, anda jangan memperkecil-
nya, tetapi biarkan program ini ber-
ada di belakang window program
yang lain.

Untuk mengakses suatu link yang
anda simpan di Sites2C, klik dua kali
link tersebut dan situs dari link itu
pun akan dibuka pada browser anda.

Penambahan link pada Sites2C dapat
dilakukan dengan dua cara yaitu
secara otomatis (drag and drop) dan
manual lewat menu Link.

Dengan menggunakan Sites2C ini

anda tidak perlu lagi menyimpan link
sementara di ‘Favorites’ (pada IE)
atau ‘Bookmarks’ (pada Netscape) se-
hingga kedua fasilitas browser itu ti-
dak terlihat berantakan karena dipe-
nuhi dengan link-link yang yang
sebenarnya bersifat sementara.
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Mulai dari mempercepat koneksi Internet sampai mempreteli nama ISP, untuk
dapat benar-benar mengontrol Internet Explorer anda perlu menyelami seluk-
beluk teknisnya Windows Registry. Inilah rahasia penggunaan IE yang belum
diketahui banyak orang.

IKA MENCOBA ME-
LIHAT Preferences
pada Internet Explor-

er, anda akan menemukan
sejumlah besar pilihan untuk
mengkonfigurasikan setting-
nya, tetapi karena IE terkait
erat dengan sistem operasi
Windows, maka untuk dapat
mengendalikannya anda
perlu langsung mengutak-
atik Windows Registry.
Registry adalah basisdata in-
formasi dan referensi sistem

operasi anda. Windows meng-
gunakannya untuk mengon-
trol begini-begitu-nya kerja
program di komputer. Saat
anda menyetel tingkat ke-
amanan (security) IE atau
hubungan (asosiasi) file pada
Windows Explorer, anda se-
sungguhnya tengah meng-
ubah sebuah entry, atau key,
pada Registry. Dan di
Registry ini terdapat banyak
key yang tidak dapat anda
ubah dari setting opsi-nya IE.

MengorMengorak Rahasia Tak Rahasia Tersembunyiersembunyi

Internet ExplorInternet Explorerer

• Program bernama RegEdit ini dapat anda jumpai di bawah folder
\WINDOWS dan dapat digunakan untuk mengedit Registry.

J

Windows 95 dan 98 menyimpan isi Registry pada dua file
binari (binary) tersembunyi di dalam direktori Windows—
SYSTEM.DAT dan USER.DAT. Windows Me mempunyai sebuah
file tambahan CLASSES.DAT. Sebaliknya Windows NT dan 2000
menyimpan file tersebut pada direktori \WINNT\SYSTEM32\
CONFIG\. Dan jika anda mengaktifkan profil pengguna (cek
pada ‘Control Panel’ → ‘Users.’), ada satu file USER.DAT untuk
setiap pengguna. Lihat di bawah C:\WINDOWS\PROFILES. Di sini
anda dapat menemukan sebuah folder untuk masing-masing
pengguna yang telah anda tentukan serta satu salinan (copy)
USER.DAT pada masing-masing profil, bersama dengan file
USER.DAT pada direktori WINDOWS yang digunakan Windows
sebagai default untuk pengguna baru.

Windows mengaktifkan atribut read-only, system, dan hidden
untuk SYSTEM.DAT, USER.DAT dan CLASSES.DAT sehingga anda
tidak akan mengganti, mengubah, atau menghapusnya secara
tidak sengaja. Klik ‘View’ → ‘Folde Options’ dan pilih ‘Show All

files’ pada tab ‘View’ pada Windows 98, atau ‘Tools’ > ‘Folder
Options’ dan klik ‘Show Hidden Files and Folders’ pada tab
‘View’ pada Windows Me.

SYSTEM.DAT berisi data konfigurasi komputer, USER.DAT berisi
data pengguna, dan CLASSES.DAT menyimpan informasi
mengenai Windows classes. Masih ada satu file, CONFIG.POL
yang bukan dari Registry, tetapi dapat mempengaruhi setting
yang anda lihat pada Registry jika anda berada pada suatu
jaringan dan menggunakan pengaturan (policy) sistem. Ketika
mulai dihidupkan, Windows akan memberlakukan semua
setting yang terdapat di CONFIG.POL pada Registry. Jika anda
memperbarui Windows anda dari 95 menjadi Windows 98,
anda mungkin akan menjumpai file bernama SYSTEM.DAO dan
USER.DAO. Ini merupakan salinan Registry yang dibuat
Windows 95 setiap kali anda mengaktifkannya. Windows 98
menggunakan Registry Checker untuk salinan sebagai file CAB,
sehingga anda tidak memerlukan file DAO.

DDiimmaannaakkaahh  kkaauu  RReeggiissttrryy??DDiimmaannaakkaahh  kkaauu  RReeggiissttrryy??
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Registry Editor
Jika anda sudah terbiasa mengutak-atik
file INI, dan CONFIG.SYS atau
AUTOEXEC.BAT, ada satu perbedaan
besar dengan Registry. Isi Registry bu-

kan berupa teks yang dapat anda buka
di editor teks apa saja, melainkan ber-
bentuk file binary (lihat ‘Dimanakah
kau Registry?’) Jadi anda memerlukan
sebuah editor khusus untuk Registry

untuk dapat melihat isinya. Anda dapat
menggunakan editor Registry bernama
RegEdit yang ada di dalam Windows
(pilih ‘Start’ > ‘Run,’ lalu ketik REGEDIT
untuk memanggilnya), atau coba

VALUE NAME item sesungguhnya
yang nilainya akan anda utak-atik.

VALUE CONTENT nilai numerik yang
akan anda ubah

SUB KEY kelompok item serupa
diatur di dalam folder-folder

KEY kumpulan sub-key serupa.
Dikelompokkan seperti file 
pada hard disk

ROOT KEY DARI BRANCH merupakan
lapisan teratas. Diberi nama seperti
‘HKEY_CURRENT_USERS’

CURRENT KEY nama lengkap key
yang tengah anda periksa atau ubah

MENU serangkaian opsi yang
memungkinkan anda mengedit key
atau menyalin Registry (disarankan
sebelum anda mengubah)

EXPORT SELURUH REGISTRY ATAU SATU
KEY BRANCH menyalin Registry.
Sebagai tindakan pengaman untuk
berjaga-jaga jika anda keliru
mengubah sebuah key. Untuk
memperbaiki kesalahan, IMPORT file
key yang anda salin tersebut.

BBAAGAIGAIMANA CARMANA CARANYANYA?A?

Antar muka (interface) RegEdit amat simpel sehingga terkesan tidak bersahabat. Walaupun demikian, RegEdit menampilkan
semua key dalam suatu struktur bergaya direktori sehingga dapat membantu anda dalam merunutnya dan memeriksa semua
isinya. (Buat salinan dengan mengekspor satu key atau satu cabang, atau bahkan seluruh Registry.)

Mengenal isi RegistryMengenal isi Registry

1
2
3
4

5
6
7

8



gunakan Registry Editor-nya Norton
Utilities atau berbagai utilitas shareware
lainnya. Windows NT dan 2000
menawarkan editor Registry alternatif
(REGEDIT32.EXE), yang memungkinkan
anda melihat dan memodifikasi tingkat
keamanan (security) dan mengubah key
yang menyimpan beberapa nilai (value).

Buat salinan Registry-nya
Sebelum mengutak-atik Registry, anda
perlu memahami arti penting Registry
bagi Windows. Setiap kali anda meng-
instal perangkat lunak (software), me-
nambah perangkat keras (hardware)
atau mengubah opsi pada Control Panel,
anda sebenarnya tengah mengubah
Registry. Itu berarti jika anda mengubah
setting yang salah secara manual, anda
dapat memporak-porandakan
keseluruhan sistem komputer anda;
program lain mungkin tidak dapat
bekerja atau bahkan mungkin Windows
anda yang tidak dapat bekerja. Jadi,
sebelum anda membuka Registry untuk
melihat-lihatnya, buatlah salinan (back-
up) file ini.

Akan tetapi anda dapat membuat
salinan file Registry di Windows
Explorer atau bahkan pada window MS-
DOS karena Windows tidak selalu
langsung menyimpan (save) perubahan
pada  Registry. Pada versi awal Windows
98, perubahan Registry tidak disimpan
sebelum anda mematikan Windows,
bahkan pada Windows versi-versi
berikutnya anda dapat mencoba
menyimpan files itu pada saat Windows
membuat perubahan sehingga anda
tidak dapat memperoleh seluruh
salinannya.

Anda dapat menggunakan Windows
Backup dan template Full System
Backup untuk menyalin file-file
Registry, atau anda dapat membuka
Registry Editor dan memilih ‘Registry’
> ‘Export Registry File’ (pertama klik
‘My Computer’ untuk mengekspor
keseluruhan Registry atau klik satu
folder jika anda hanya membuat
perubahan pada isi folder itu).

Langkah ini akan menciptakan file .REG
yang dapat anda buka pada sebuah edi-
tor teks dan dapat anda kembalikan
(restore) jika ada sesuatu yang keliru.

Masalahnya adalah bahwa agar dapat
mengembalikan salinan itu, anda perlu
menjalankan Registry Editor kembali
dan memilih ‘Registry’ → ‘Import’ (klik
dua kali file .REG pada Explorer). Jika
kekeliruan sudah parah sehingga anda
tidak dapat menjalankan Windows, anda
harus menginstal ulang Windows untuk
memperoleh kembali Registry Editor.
Salah satu caranya adalah dengan mem-
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HKEY_CLASSES_ROOT

HKEY_CURRENT_USER

HKEY_LOCAL_MACHINE

HKEY_USERS

HKEY_CURRENT_CONFIG

HKEY_DYN_DATA CURRENT VERSION

PERSISTENT=”I”

CONNECTIONS

URL HISTORY

INTERNET SETTINGS

SOFTWARE

MICROSOFT

WINDOWS

CACHE

Bagaimanakah Registry ditata?
Setiap branch Registry
mempunyai banyak key dan
sub-key, yang masing-masing
dapat mempunyai beberapa
nilai (value)

KETERANGAN:

KEY

VALUE

HKEY_CLASSES_ROOT
Cabang (branch) ini menyimpan file
asosiasi, informasi OLE (Object Linking
and Embedding) untuk penyertaan satu
jenis file sebagai suatu objek pada file
lain (sebuah bagan Excel pada suatu
dokumen Word, misalnya) di samping
tombol-tombol pintas Windows serta
beberapa rincian penting perihal antar
muka (interface) pengguna.

HKEY-_USERS
Jika Windows anda disetel untuk be-
berapa pengguna, cabang ini menyim-
pan preferensi individual untuk setiap
pengguna. Informasi didapat dari
berbagai file USER.DAT pada sistem.

HKEY_CURRENT_USER
Cabang ini membuat link dengan ba-
gian HKEY_USERS untuk siapa pun yang
tengah menggunakan PC tersebut pada
saat itu; di dalamnya tersimpan rincian
seperti document list yang tengah
digunakan, nama log-on, desktop
setting, dan setting menu Start.

HKEY_LOCAL_MACHINE
Cabang ini menyimpan informasi

spesifik mengenai perangkat keras,
perangkat lunak dan preferensi di PC;
jika anda mempunyai konfigurasi be-
berapa perangkat keras, semuanya
disimpan di sini.

HKEY_CURRENT_CONFIG
Cabang ini membuat link ke bagian
dari HKEY_LOCAL_MACHINE untuk kon-
figurasi perangkat keras yang saat ini
digunakan, terutama untuk setting
video dan printer.

HKEY_DYN_DATA
Cabang ini menunjuk pada bagian dari
HKEY_LOCAL_MACHINE yang berurusan
dengan perangkat keras Plug-and-Play.
DYN adalah singkatan dari dynamic dan
cabang ini berubah pada saat anda
menambah atau mengurangi perangkat
dari komputer anda. Di samping itu ada
juga beberapa catatan yang dikumpul-
kan Windows tentang performanya
sendiri sehingga sesuai dengan kebu-
tuhan, di samping untuk mengontrol
beberapa fungsi internal yang berawal
dan berakhir pada start-up dan shut
down-nya Windows.



boot dengan menggunakan mode MS-
DOS dan menyalin file Registry ke direk-
tori back-up; jika Windows masih tidak
dapat berjalan, anda dapat kembali ke
DOS dan mengembalikan (restore) file-
file dari sana.

Opsi lainnya adalah dengan mengguna-
kan piranti back-up Registry Checker;
fitur ini akan menyalin Registry anda
setiap hari pada saat anda
menghidupkan PC dan menyimpan
salinan lima hari terakhir. Windows
menyimpan file-file ini sebagai file CAB
di C:\WINDOWS\SYSBCKUP. Setiap kali
anda menghidupkan komputer, Registry
Checker akan men-scan Registry anda
dan jika ada masalah secara otomatis
akan mengganti Registry tersebut
dengan back-up-nya. Pilih ‘Start’ →
‘Run’ dan ketik SCANREGW untuk
membuat salinan ekstra, tetapi ingat
bahwa file itu akan diganti dalam waktu
lima hari sehingga anda mungkin perlu
membuat salinan file CAB untuk
berjaga-jaga jika terjadi keadaan darurat.

Jika anda masih menggunakan Windows
95, cobalah program Microsoft Confi-
guration Back-up, CFGBACK.EXE, yang
dapat anda temukan di direktori
\OTHER\MISC\CFGBACK pada CD-
ROM Windows 95. Utilitas ini me-
mungkinkan anda membuat file salinan
Registry sampai sembilan buah yang
akan disimpan dengan ekstensi RBK,
pada direktori WINDOWS. Walaupun
demikian, jika sistem anda disetel untuk
beberapa pengguna, CFGBACK.EXE tidak
akan menyalin file USER.DAT untuk
anda. Anda dapat menyalin file .RBK di
lain tempat, tetapi Windows 95 hanya
dapat mengembalikannya dari sebuah
file back-up pada direktori WINDOWS,
dan mengkompres file itu sehingga
anda dapat mengembalikannya hanya

dengan menggunakan utilitas
CFGBACK.EXE.

Agar ekstra aman, jangan membuat
terlalu banyak perubahan pada Registry
tanpa mentes sistemnya. Buat perubah-
an pertama, kemudian restart PC anda;
jika Windows berjalan mulus, anda da-
pat melanjutkan dengan langkah beri-
kutnya, mulai dengan membuat salinan
baru dengan nama file berbeda. Jika
tidak, kembalikan setting Registry-nya
dari file salinan anda dan coba kembali.

Jadi apa sebenarnya Registry itu?
Registry sebenarnya hanya basisdata
dari file konfigurasi yang digunakan
untuk menyimpan informasi, setting
dan opsi untuk semua urusan di Win-
dows, mencakup perangkat keras, pe-
rangkat lunak, pengguna dan preferensi.
Hampir semua program Windows 32-
bit menyimpan data konfigurasinya,
dan preferensi anda, di Registry.

Registry menyimpan konfigurasi pe-
rangkat keras PC anda, termasuk secara
otomatis mengkonfigurasikan perangkat
Plug-and-Play. Di sini pulalah Windows
menyimpan rincian konfigurasi perang-
kat keras lain—jika anda mempunyai
laptop dan docking station, misalnya—
dan beberapa pengguna, lengkap dengan
preferensi mereka.

Registry juga menyimpan cara perang-
kat lunak anda menambahkan fitur
tambahan pada Windows, seperti perin-
tah baru pada menu jalan pintas. Selain
itu, juga memungkinkan anda membuat
semua jenis perubahan pada Internet
Explorer, seperti perubahan cara kerja
Link dan Favorites; pemilihan logo atau
judul untuk title bar window; penyetel-
an mesin pencari default; penyetelan
konfigurasi TCP/IP; dan pengubahan
Control Panel serta setting cache.

Registry mempunyai enam cabang hie-
rarkis (hierarchical branches), dengan
ratusan entry pada setiap cabang. Setiap
cabang utama diawali dengan ‘root key’
yang berisi ‘key.’ Sebaliknya sebuah key
mungkin berisi ‘sub-key’ dan baik key
maupun sub-key berisi ‘value.’ Value
atau nilai inilah yang berisi informasi
aktual yang disimpan pada Registry.
Setiap entry dIsimpan sebagai suatu
pasangan (pair)—nama entry dan nilai
yang diberikan padanya.

Nilai yang terdapat pada Registry key
dapat berbentuk data binari (binary),
text string atau apa yang disebut
'DWORD.' Nilai REG_BINARY adalah
data binari mentah yang dapat anda
lihat dalam format heksadesimal; nilai
ini merupakan informasi mengenai
komponen perangkat keras sehingga
anda tidak dapat menggunakannya
untuk tweaking IE. Nilai REG_SZ adalah
text string sederhana yang sebenarnya
dapat anda baca.

Kebanyakan Registry key yang kerap
anda ubah, yang menggunakan angka
byte empat untuk menyimpan data,
kerap 0 untuk disabled atau 1 untuk
enabled. Anda dapat melihat hal ini
pada REGEDIT sebagai heksadesimal
(tampilannya akan seperti ini: 01 00 00
00 dan 00 00 00 00) atau desimal (1 dan
0).

Key yang berpengaruh terhadap IE
muncul pada beberapa cabang berbeda
pada Registry. Tempat paling tepat un-
tuk melihatnya adalah
HKEY_CURRENT_USER\Software\Micr
osoft\Internet Explore\Main\ tetapi
anda mungkin perlu mengubah setting
TCP\IP pada HKEY_LOCAL_MACHINE\
System\CurrentControlSet\Services\.

Lebih jauh lagi, Windows menyimpan
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SEARCH Gunakan fungsi Search—
ketimbang mencari satu per satu
pada ratusan key—untuk menemu-
kan key yang anda inginkan. Cari

nama atau nilai key. Makin spesifik penca-
rian anda, makin terbatas pula hasil
pencariannya.

1 EDIT Inilah pengeditan nilai
REG_DWORD pada heksadesimal
(base 16); anda dapat mengklik
masing-masing nilai bit untuk

mengubahnya, atau memilih yang
pertama dan mulai mengetik dari sana.

3EXPAND Ketika menemukan key yang
anda inginkan, klik key itu untuk
melihat seluruh nilai atau perluas
(expand) key itu sehingga anda dapat

memilih satu nilai. Untuk mengedit satu
nilai, klik-kanan dan pilih 'Modify.'

2

BBAAGAIGAIMANA CARMANA CARANYANYAA
Menggarap key pada RegEdit



Registry entry yang langsung berkaitan
dengan performa sistem operasi di
bawah HKEY_LOCAL_MACHINE
\SOFTWARE\MICROSOFT\WINDO
WS\CURRENTVERSION—dan itu
mencakup entry yang mengontrol
Windows Explorer, yang dapat
mempengaruhi IE.

IE dan Registry
Misalnya, setting yang mengontrol
cache tempat IE menyimpan halaman-
halaman Web yang pernah dikunjungi
adalah di HKEY_LOCAL_MACHINE\
SOFTWARE\Microsoft\Windows\Curre
ntVersion\Internet Settings\Cache\. Jika
anda menyimpan halaman-halaman ini
pada cache anda, maka Persistent key
akan diset pada “01 00 00 00” atau “1”.
Dan jika anda secara otomatis mengha-
pusnya, Persistent=”00 00 00 00” atau “0”.

Seberapa lama file-file tersebut tersim-
pan di cache anda bergantung pada nilai
yang disimpan (dalam detik) di
CleanupInterval key. Default-nya adalah
tujuh hari —yaitu 86. 400 detik dalam
satu hari dan 604.800 detik dalam satu
minggu, yaitu 93A80 dalam heksadesi-
mal (base 16). Ingat, data itu disimpan
dalam urutan terbalik oleh Registry dan
dilengkapi dengan 0 sehingga akan
tampak seperti ini "80 3A 09 00".

Pada saat menjalankan Registry Editor,
anda akan melihat enam pohon (tree)
dengan enam folder pada bagian kiri
(root key) dan nilainya pada bagian ka-
nan. Perluas (expand) root key tersebut
untuk keenam cabang (branch)-nya
dengan mengklik tanda + atau mengklik
key-nya sebanyak dua kali, seperti pada
Windows Explorer. Untuk melihat isi
sebuah key, pilih key itu pada pohon-
nya, dan anda pun dapat melihat semua
nilainya pada sisi kanan.

Penggunaan RegEdit
Tambahkan sebuah key atau nilai baru
dengan memilih Edit > New atau

dengan mengklik tombol kanan mouse
pada parent key. Ubah sebuah nilai atau
rename hampir semua key seperti
halnya jika anda melakukan rename
pada Explorer: pilih 'Edit' > 'Modify,'
klik tombol kanan dan pilih rename,
atau klik sekali untuk memilih dan
kedua kali untuk mengedit, atau tekan
saja F2. Hapus sebuah key atau nilai
secara menyeluruh dengan mengklik
key atau nilai itu lalu menekan tombol
Delete atau klik-kanan dan memilih
Delete.

Ketimbang melakukan browsing lewat
beberapa entry—jumlahnya mungkin
ratusan pada sub-key yang lebih besar -
—gunakan Edit → Find dan Edit →
Find Next untuk mencari key dan nilai
khusus. Isikan seluruh word atau ni-
lainya, atau hanya sebagiannya. Jika
anda membuat perubahan dan berpikir
untuk mengembalikannya ke asalnya,
pilih 'Favorites'→ 'Add to Favorites'
untuk membuat Bookmark. Cara ini
juga berguna untuk kembali ke key
yang anda gunakan secara reguler.

Anda juga dapat mengimpor file .REG
untuk mengedit key khusus di dalam
Registry ('Registry' → 'Import') dan
jika banyak key yang anda perlu ubah,
anda dapat membuat sebuah file teks
dengan semua rinciannya. Jika anda
ingin menghapus key itu atau sebuah
nilai, gunakan tanda minus pada file
teks tersebut. Misalnya, [-HKEY_
LOCAL_MACHINE\SYSTEM\Setup]
atau [HKEY_LOCAL_MACHINE\
SYSTEM\Setup]

“SetupType”=-

Pastikan bahwa anda memasukkan key
yang benar jika anda melakukannya
dengan cara ini, dan jangan lupa
membuat salinan Registry-nya terlebih
dahulu.

NeoStart
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• Secara fisik, Registry adalah infor-
masi yang terdapat pada SYSTEM.DAT,
USER.DAT dan CLASSES.DAT. Secara
logis, Registry adalah data konfigurasi
yang anda lihat ketika anda
menjalankan Registry Editor; anda
melihat semua informasinya,
walaupun berada pada file-file
terpisah.

• Keenam cabang (branch) Registry
disebut 'root key.' Masing-masing
cabang mempunyai nama yang
diawali dengan HKEY_. Di dalam root
key terdapat 'key,' dan setiap key
dapat berisi 'sub-key' dan satu 'value'

atau lebih. Bayangkan mereka seperti
folder di Windows.

• Anda juga dapat menyebut key atau
sub-key mana saja serta segala
sesuatu yang dikandungnya sebagai
suatu 'branch.' Nilai pada suatu key
atau sub-key merupakan pasangan
nama dan nilai, disebut 'value entry.'

Setiap key mempunyai default value
(yang bisa berisi sepotong informasi
yang sebenarnya tetapi mungkin juga
kosong) dan default value untuk
setiap key disebut [Default] pada
Registry Editor.

Istilah pada Registry

INSTALASI ZOC
Instal ZOC Terminal Emulator
dengan men-double click ikon-
nya dan ikuti langkah-langkah
instalasinya. Instalasi ini sifatnya
langsung dan sangat mudah
diikuti.

1

PROMPT $
Setelah anda mengetikkan nama
login dan password, anda pun
masuk ke unix shell ini dan
mendapatkan prompt Unix yang
kesohor itu, yaitu prompt $. Dari
sini anda sudah bisa mengetikkan
perintah-perintah Unix.

5

enggunakan Microsoft Telnet
untuk menciptakan Unix Shell
Account di Freeshell.org telah

dibahas di NeoTek Vol II No 2
(November 2001). Untuk menciptakan
account ini anda harus menjalankan
telnet ke sdf.lonestar.org.

Ada banyak yang anda dapat lakukan
dengan unix shell account gratis ini. anda
dapat menempatkan situs Web anda dan
20 Mb cukup besar untuk situs Web
pribadi, bukan?

Account gratis di Freeshell ini tidak me-
mungkinkan kita mengadakan koneksi
FTP padanya, jadi bagaimana kita dapat
meletakkan file-file kita?

ZOC Terminal Emulator jawabannya.
Dengan ZOC anda dapat meng-upload
dan men-download file ke/dari unix shell
account ini dengan fasilitas Zmodem.

M
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AUTOCONNECT
Klik OK danproses Autoconnect
berjalan dan tak lama kemudian
anda terhubung ke sdf.lonestar.org
pada IP 209.221.165.117 dan
anda diminta login. Masukkan
nama login yang telah anda
punyai.

4CONNECT KE FREESHELL
Pada Connection, isikan
sdf.lonestar.org dan pada Device
isikan telnet. Emulation biarkan
saja seadanya. Bila ingin serupa
dengan MS telnet sewaktu
pendaftaran dulu, pilih VT100

3

WEB HOSTING GRATIS!
Pada prompt $ ketikkan mkhomepg
dan anda diminta menempatkan
halaman-halaman web anda di
/udd/n/nama/html, pada contoh
ini di /udd/k/kosasih/html.
Ketikkan ls untuk memastikan
direktori html, lalu cd html

6

Fasilitas upload dan download dapat menggantikan fungsi FTP
yang tidak diperkenankan pada unix shell gratis seperti pada freeshell.org (sdf.lonestar.org)

JALALANKAN ZOC
Jalankan ZOC Terminal Emulator
dengan memilih Start >
Programs > ZOC Terminal > ZOC
dan jendela dialog Manual
Connection segera dibuka. Anda
diminta mengisikan Connection,
Device, dan Emulation.

2

UPLOAD HALAMAN WEB
Kini upload halaman-halaman
web dari situs anda dengan
memilih Transfer > Upload yang
akan menampilkan jendela dialog
Select Zmodem-Upload File(s).
Pilih file-nya lalu klik Open dan
upload akan berlangsung.

7
HOME PAGE ANDA!
Setelah upload semua halaman web
yang perlu lengkap dengan file-file
gambarnya, kini buka browser ke
http://nama.freeshell.org/index.htm
yang dalam contoh ini adalah
http://kosasih.freeshell.org/index.htm
Nah, ini dia home page anda!

8

TTEELNLNEET DT DAN UAN UPPLLOOAD PAD PADADAA
TTEERRMMIINAL ENAL EMMUULLAATTOORR
ZZOOC 4.0.3C 4.0.3
Repot menggunakan MS Telnet yang primitif itu? Gunakan
Z.O.C. Terminal Emulator yang selain memberikan fasilitas telnet,
juga memungkinkan kita meng-upload dan men-download
file ke dan dari remote server, selain juga dapat mengirimkan
file teks atau binari seperti layaknya FTP client.

• Download ZOC  Terminal Emulator 4.0.3 di
http://www.emtec.com/download.html dan pilih file

zoc_403_win_english.exe.
Selain di situs resminya, software ini dapat juga di-

download di:
http://www.freedownloadscenter.com

http://5star.freeserve.com
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Sejak pertama kali HTML tidak pernah dirancang untuk menyampaikan
konsep yang 'full-grafis,' melainkan sekedar menyampaikan teks biasa
pada halaman Web. HTML bukan untuk menampilkan desain halaman,
melainkan struktur informasi yang terkandung.

ENGAN BERKEMBANGNYA HTML,
tag-tag baru diperkenalkan dan
teknologi baru ditambahkan

pada HTML. Tujuannya adalah agar
desainer halaman Web dapat lebih me-
ngendalikan struktur dan penampilan
dokumen seperti frame, table, pengen-
dalian rata kiri, kanan, atau center
(justification), dan tentunya Javascript.
Tetapi konsekuensinya adalah loading
halaman Web menjadi lambat,
terutama bila berurusan dengan grafik.

Karena masalah-masalah di atas, maka
World Wide Web Consortium (W3C)
memperkenalkan Cascading Style
Sheet (CSS) untuk mengatasi keku-
rangan yang ada pada HTML. Wah!

Apa lagi ini. Baru saja anda mengenal
HTML, kini sudah harus mempelajari
lagi CSS. Apa pengetahuan yang baru
didapat mengenai HTML akan percu-
ma karena harus mempelajari DHTML?

Jangan khawatir, bila anda telah me-
ngenal HTML, maka mempelajari CSS
akan mudah. CSS bekerja langsung
pada tag HTML dan mengatur bagai-
mana seharusnya tag-tag ini ber-
perilaku.

Ambil contoh tag <bold> pada HTML
yang digunakan untuk membuat teks
tercetak tebal. Dengan menggunakan
CSS, anda dapat 'meredefinisi' tag ini
sehingga akan tercetak lebih tebal lagi,

atau untuk penekanan lebih jauh lagi,
mengatur agar semua teks tercetak
dalam huruf kapital. Atau malah mem-
buat teks tidak tercetak tebal.

Apa Sih Style Itu?
Karena HTML hanya berurusan de-
ngan struktur, anda yang mempela-
jarinya tidak benar-benar memahami
atau terasah seleranya terhadap desain.
Kita belajar lebih dahulu sedikit men-
jadi desainer dengan memahami apa
yang dimaksud dengan style.

Style terdapat terutama pada program
desktop publishing. Program word
processing pun kini mendukung Style.

D

Dynamic Dynamic HHTTMMLL

• Style yang diterapkan pada bagian judul dalam bentuk tag pada
program word processing.

• Style sheet yang diterapkan pada suatu tag HTML. Bandingkan
analoginya dengan tag pada program word processing di sebelah kiri.

Memahami CascMemahami Cascading Stading Style Sheet (Cyle Sheet (CSS S)S)

bold
times
italic

12pt

Styles yang
diterapkan

Nama style Dokumen

Bagian Judul

Part I—DHTML
teks teks teks teks teks teks
teks teks teks teks teks teks
teks teks teks teks teks teks
teks teks teks teks teks teks

Part II—CSS
teks teks teks teks teks teks
teks teks teks teks teks teks
teks teks teks teks teks teks
teks teks teks teks teks teks 

}
bold
times
italic

12pt

Styles yang
diterapkan

Tag HTML Dokumen

<h1>…</h1>
Part I—DHTML
teks teks teks teks teks teks teks teks
teks teks teks teks teks teks teks teks
teks teks teks teks teks teks teks teks

Part II—CSS
teks teks teks teks teks teks teks teks
teks teks teks teks teks teks teks teks
teks teks teks teks teks teks teks teks 

}
!!"
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Style adalah cara untuk mengatur pe-
nampilan komponen dokumen secara
keseluruhan. Misalnya style untuk
judul, style untuk subjudul, syle
untuk caption, dan lain sebagainya.

Style merupakan kumpulan semua
atribut yang ada pada suatu dokumen
yang mengatur penampilannya, seperti
format dan ukuran font, dan kelompok-
kelompok atribut ini diberi nama (nama
style) tertentu. Misalnya anda ingin
agar subjudul ditetapkan sebagai bold,
font-nya Times, italic, dengan besar 14
point. Kumpulan atribut ini dapat dibe-
ri nama style Subjudul.

Apa yang Dimaksud dengan CSS?
Apabila style menetapkan penampilan
pada halaman word processing, maka
yang serupa juga berlaku untuk hala-
man web dengan CSS. Anda dapat
mengatur CSS agar mempengaruhi
sifat-sifat tag HTML pada satu hala-
man Web tertentu atau untuk keselu-
ruhan dokumen.

Walaupun metodologi CSS bekerja
pada HTML, CSS itu sendiri bukanlah
HTML. CSS merupakan kode-kode
tersendiri yang meningkatkan kemam-
puan HTML, dengan cara mendefini-
sikan ulang tag-tag HTML.

Sebagai contoh, tag paragraf <p> …
</p> yang pada dasarnya meletakkan
baris kosong di antara dua paragraf.
Dengan CSS anda bisa mengatur
bahwa tag ini bukan hanya meletak-

kan baris kosong, melainkan teks di
antara kedua tag itu ditetapkan misal-
nya bold, dengan font Times, dan 14
point.

CSS dan HTML 4.01
Mulai HTML 4.01, yang diperkenal-
kan Desember 1999, HTML menyer-
takan style-sheet methodology. Ini
bukan berarti CSS itu sama dengan
HTML, melainkan HTML kini tergan-
tung pada CSS untuk mengatur penam-
pilan halaman Web, bukan lagi dengan
tag-tag HTML yang berhubungan de-
ngan desain.

Artinya, walaupun tag-tag pada HTML
yang berhubungan dengan desain ma-
sih berjalan, anda dianjurkan menggu-
nakan CSS dalam mengaturnya. Fal-
safahnya adalah: sedapat mungkin be-
baskan HTML dari kewajiban menga-
tur desain. Pakailah CSS untuk itu.

Dengan cara ini 'orang-orang amatiran'
masih dapat mengatur tampilan hala-
man Web dengan menggunakan tag-tag
HTML dan 'desainer betulan' meng-
gunakan CSS.

Versi-versi CSS
Mengikuti petunjuk dari W3C, CSS
telah berkembang selama beberapa ta-
hun terakhir ini. Browser-browser
mutakhir mendukung CSS yang mu-
takhir pula.

CSS Level 1 (CSS1).. Versi resmi perta-
ma ini dilepas tahun 1996. Memuat ke-

mampuan dasar CSS sepert memfor-
mat teks, mengatur font, dan menyetel
margin. Didukung oleh Netscape 4 dan
Internet Explorer 3 dan 4.

CSS Positioning (CSS-P). Sambil me-
nunggu versi baru, para desainer Web
sudah memerlukan standar untuk me-
letakkan suatu unsur secara tepat pada
halaman Web.

CSS Level 2 ( CSS2). Versi terbaru
yang dilepas pada tahun 1998. Dukung-
an terhadap bahasa internasional dan
kemampuan menspesifikasi CSS yang
spesifik untuk media tertentu. Didu-
kung oleh Internet Explorer 5 dan
Netscape 6.

CSS Level 3 (CSS3). Standar yang ma-
sih dalam pengembangan. Akan mene-
tapkan standar untuk Scalable Vector
Graphics (SVG). Format ini memung-
kinkan anda menyertakan bentuk-
bentuk dalam vector dan bukannya
bitmap.

Gampang Kok Membuat CSS Itu!
CSS tidak memerlukan segala macam
plug-in. Pada dasarnya CSS hanya
berisi aturan-aturan saja. Aturan-
aturan CSS mendefiniskan bagaimana
HTML harus tampil dan berperilaku
pada jendela suatu Web browser.

Anda dapat menetapkan aturan-
aturan untuk memerintahkan tag
HTML tertentu untuk menampilkan
isinya, atau anda dapat juga menetap-
kan suatu aturan umum dan kemu-

Buka file ini dengan
browser. Inilah file HTML
anda yang pertama yang
menggunakan CSS!

1 Pada Notepad ketikkan
style= pada tag yang
diredefinisi, yaitu:
<h1 style=

2 Di antara tanda petik, ketik
definisi (property:value)
titik koma (;) membatasi
setiap definisi.

3 4 Setelah menutup tag ini,
ketikkan teksnya dan tutup
dengan tag penutupnya:
Judul Makalah Saya</h1>

5 Misalkan redefinisi juga
<h2> sebagai berikut:
<h2 style="font-size
:24px;color:blue;">

6 Teksnya adalah Yang Ini
Sub-Judulnya, maka
keseluruhan dokumen
HTML-nya terlihat di atas

7 Selanjutnya Save sebagai
file teks dengan ekstensi
*.htm, misal dengan nama
csstotag.htm

8

Pastikan bahwa daftar
definisi ini diakhiri de-
ngan tanda petik juga.

CSS pada Tag HTML Sebagai contoh, kita akan meredefinisi tag <h1> … </h1>
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dian menetapkannya berdasarkan ke-
perluan. Ada tiga jenis aturan CSS:
HTML Selector, Class, dan ID. Terle-
bih dahulu, kita bahas yang pertama.

HTML Selector adalah bagian teks
dari suatu tag HTML. Misalnya pada
tag <h3> HTML Selector-nya adalah
h3. Pada <img scr = "gambar.gif'>,
maka HTML Selectornysa adalah iimmgg
(scr bukan selector, melainkan atribut).

CSS hanya bekerja dengan tag-tag
yang disertai penutup. Sebagai con-
toh, walaupun pada HTML <p> sering
digunakan tanpa pasangannya </p>,
apabila menggunakan CSS maka
keduanya harus digunakan.

Bentuk umum sintaks CSS adalah
sebagai berikut:

Selector{property:value;}
Selector di sini bisa HTML selector,
Class, atau ID. Definisi terdiri atas
property yaitu atribut yang didefini-
sikan dan value yaitu pendefinisian
property tadi.

Di Mana Meletakkan Aturan CSS?
Aturan CSS dapat diletakkan di tiga
tempat yaitu:

• Di dalam tag HTML, untuk mem-
pengaruhi tag tertentu saja

• Pada head dari dokumen, untuk
mempengaruhi keseluruhan
halaman Web

• Pada dokumen eksternal, untuk
mempengaruhi keseluruhan situs
Web

CSS pada Tag HTML

Sebagai contoh, kita akan mendefini-
sikan ulang tag <h1> … </h1> yang
berisi teks 'Judul Makalah Saya.'

1.Ketikkan style= dalam tag HTML
yang akan diredefinisi:

<h1 style=

2.Di antara tanda petik, ketikkan
definisi-definisi (property:value)
dengan titik koma (;) untuk mem-
batasi tiap-tiap definisi itu. Pastikan
bahwa daftar definisi ini diakhiri
dengan tanda petik juga.

"font-size:48px;color:red;"

3.Setelah menutup tag ini, ketikkan
teksnya dan tutup dengan tag
penutupnya:

>Judul Makalah Saya</h1>

4.Misalkan pula pendefinisian ulang
untuk <h2> sebagai berikut:

<h2 style="font-size:24px;

color:blue;">

5.Teksnya adalah Yang Ini Sub-
judulnya, maka keseluruhan contoh
pada dokumen HTML-nya akan
sebagai berikut:

<html>

<h1 style="font-size:48px;

color:red;">

Judul Makalah Saya

</h1>

<h2 style="font-size:24px;

color:blue;">

Yang Ini Sub-judulnya

</h2>

</html>

6.Selanjutnya kita lengkapi dengan
bodytext style sebagai berikut:

<body style ="background:pink;

font-family:arial;">

yang diletakkan paling awal setelah
<html>

Penutupnya </body> paling bawah
sebelum </html>;

Adapun paragraf body text
diletakkan setelah <h2>…</h2>

Sehingga keseluruhan dokumen
akan menjadi:

<html>

<body style ="background:pink;

font-family:arial;">

<h1 style="font-size:48px;

color: red;">

Judul Makalah Saya

</h1>

<h2 style="font-size:24px;

color:blue;">

Yang Ini Sub-Judulnya

</h2>

<p>

Ini body text-nya. Ini body 

text-nya. Ini body text-nya. 

Ini body text-nya.

</p>

</body>

</html>

CSS pada Halaman Web
Untuk mendefinisikan aturan-aturan
style pada keseluruhan halaman web,
anda perlu menyertakan aturan-aturan

style ini pada head dari dokumen
yang membentuk nest dalam suatu
style container. Cara penempatannya
tampak sama seperti dengan menem-
patkan langsung pada tag HTML, te-
tapi memudahkan anda untuk mela-
kukan perubahan di masa datang
karena semua terkumpul di satu tempat.

Syntax umum CSS style ditempatkan
pada bagian <head> dari doukmen
HTML sebagai berikut:

<style type="text/css">

aturan-aturan CSS

</style>

Sehingga bentuk dokumen HTML-
nya menjadi:

<html>

<head>

<style type="text/css">

body {

background:pink;

font-family:arial;}

h1 {

font-size:48px;

color:red; }

h2 {

font-size:24px;

color:blue;}

</style>

</head>

<h1>Judul Makalah Saya

</h1>

<h2>Yang Ini Sub-Judulnya

</h2>

<body>

<p>

Ini body text-nya. Ini body text-nya. Ini

body text-nya. Ini body text-nya.

</p>

</body>

</html>

CSS pada Keseluruhan Situs Web
Manfaat utama dari CSS adalah
bahwa anda dapat menciptakan satu
style sheet dan menerapkannya bukan
hanya pada satu halaman Web saja,
melainkan untuk keseluruhan situs
Web. Anda dapat menerapkan style
sheet eksternal ini pada ratusan doku-
men HTML, tanpa harus mengetikkan
ulang informasinya satu per satu.

<h1 style=”color:red;”>…</h1>

HTML
selector

Tag penutupDefinisi

Property Value ContentAtribut
style

Tanda sama dengan

<style type=”text/css”>
h1 {color:red;}

</style>

Style tag CSS ruleMendefinisikan style type



Menerapkan CSS eksternal mencakup
proses dua langkah. Pertama, menetap-
kan aturan-aturannya pada suatu file
teks; kemudian me-link atau impor
file ini ke suatu dokumen HTML, baik
itu dengan tag <<lliinnkk>> atau @@iimmppoorrtt.

Menciptakan File CSS Eksternal
Gunakan text processor biasa (misal,
Notepad) untuk membentuk file CSS
eksternal. Pada file CSS eksternal ini
jangan gunakan  tag <style> sebab
tidak akan bekerja pada kebanyakan
browser.

Ketikkan sebagai berikut:

h1 {

font-size:48px;color: red; }

h2 {

font-size:24px;color:blue;}

Lalu save sebagai file teks dengan
ekstensi *.css, misalnya filename.css

Buat lagi file teks lain yang isinya
sebagai berikut:

body {

background:pink;

font-family:arial;}

lalu save sebagai file teks css lain,
misalnya filename2.css.

Adapun file HTML yang dibuat akan
terhubung (link) ke file css ini dengan
pernyataan <link> sebagai  berikut:

<link rel="stylesheet" href="filename.css">

sehingga keseluruhan dokumen akan
sebagai berikut:

<html>

<head>

<link rel="stylesheet"

href="filename.css">

<link rel="stylesheet"

href="filename2.css">

</head>

<body>

<h1>Judul Makalah Saya

</h1>

<h2>yang Ini Sub-Judulnya

</h2>

<p>

Ini body text-nya. Ini body text-nya. Ini

body text-nya. Ini body text-nya.

</p>

</body>

</html>

Cara lain untuk membawa style sheet
eksternal ini agar digunakan pada
suatu dokumen adalah dengan meng-
gunakan penyataan @import.

Untuk mengimpor file CSS eksternal,
pertama kali tetapkan di antara head
dokumen HTML anda:

<stylesheet="text/css">

lalu impor file CSS dengan pernyataan:

@import url(filename.css)
@import url(filename2.css);

ulangi pernyataan di atas sebanyak
yang diinginkan

Bila ada aturan CSS lain yang ingin
dimasukkan, letakkan di sini.

Tutup dengan </style>

Dokumen HTML yang mengimpor
style sheet eksternal akan berbentuk
sebagai berikut:

<html>
<head>

<style type="text/css">
@import url(filename.css);

@import url(filename2.css);
</style>

</head>
<body>
<h1>Judul Makalah Saya</h1>
<h2>Yang Ini Sub-Judulnya</h2>
<p>
Ini body text-nya. Ini body text-nya. 
Ini body text-nya. Ini body text-nya.
</p>
</body>

</html>

Dengan sifat-sifat CSS yang portabel
ini, untuk membuat desain yang baik,
anda tinggal mencarinya saja di
koleksi CSS yang banyak tersedia di
Internet. Jadi semakin mudah, bukan?
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•File-file CSS eksternal tidak hanya dapat digunakan pada banyak file HTML (CSS2), melainkan dapat juga diimpor (tetapi tidak di-link) ke file CSS yang lain (CSS3).
File-file CSS, baik yang diimpor maupun di-link, bertindak sama persis seperti apabila anda mengetikkan kodenya ke dalam file tempatnya di-link atau di-impor.

CSS3

CSS2

HTML1

HTML2

CSS1

<link>
@import

@import

<link>
@import

<link>
@import
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enggunaan Class yang
paling jelas adalah pada saat
anda membuat suatu

paragraf tentang pertanyaan dan
jawabannya atau dalam suatu situs
biasanya dinamakan FAQ
(Frequently Asked Questions).
Paragraf yang berisi pertanyaan
diberi sentuhan style yang berbeda
dengan  jawabannya.

Contohnya seperti pada Langkah 1-2
di mana setiap class didekalarasikan
lebih dulu di bagian
<STYLE>...</STYLE> yang
dimasukkan pada tag <HEAD>.
Penamaannya harus didahului

DDYYNAMNAMIIC HC HTTMMLL
CCLLAASSS DS DAN EAN EXXTTEERRNALNAL
SSTTYYLE SLE SHHEEEETSTS

Class dan External Style Sheets banyak dipakai para Webmaster
untuk membuat halaman Web menjadi lebih hidup. Bagaimana
cara membuat dan menggunakannya, ikuti tutorial berikut ini.

P

MEMBUAT FILE *.CSS
Untuk menggunakan external style sheet,
buat dahulu file style sheet dengan
format *.css. Setelah anda membuat
konfigurasi style sheet, simpan sebagai
css dengan memberi ekstensi .css pada
file yang dibuat pada notepad. Pada
contoh ini, kita buat styleku.css

MEMBUAT LINK KE FILE CSS
Untuk memasukkan file css ke dalam
dokumen HTML, masukkan tag <LINK
REL=stylesheet HREF=”styleku.css”>
ke setelah </TITLE> dan sebelum
</HEAD>. Lalu gunakan class tersebut
seperti biasa.

MEMBUAT CLASS
Buka Notepad dan tuliskan kode-kode
HTML seperti di atas lalu save sebagai
htmlconfr.htm. Perhatikan bagian yang
disorot. Ada dua class yang dibuat
yaitu: .question dan .answer. Untuk
memasukkannya ke paragraph, ketik
<P class=”nama class”> .......</P>

PREVIEW DENGAN BROWSER
Setelah di-Save as HTML, buka dokumen
pada Langkah 1 dengan browser. Ada
dua class yang kita masukkan dalam tiap
paragraph di atas yaitu question (italic)
dan answer yang bisa diterapkan untuk
setiap pertanyaan dan jawaban dalam
halaman Web anda.

1

5 6

2

CSS untuk atribut font. text, border, dan margin

MENGGUNAKAN
MICROSOFT
FRONTPAGE 2000

?

Microsoft FrontPage 2000
juga bisa digunakan
untuk membuat
Cascading Style Sheets.
Caranya:

1. Klik Format>AStyle

2. Klik salah satu Styles
misal: p lalu klik Modify

3. Pada window Modify
Style, klik Format
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dengan sebuah titik, misalnya:
.question {font-style:italic} dan
.answer {color:#23238e}.

Kemudian pada bagian <BODY>,
masukkan nama class itu dalam tag
yang diinginkan misalnya:

<<PP  ccllaassss==”” qquueessttiioonn”” >>........<<//PP>> dan 
<<PP  ccllaassss==”” aannsswweerr”” >>........<<//PP>>. Dengan
demikian, kita telah membuat dua
paragraf dengan class style berbeda.

Tetapi jika anda ingin memasukkan
suatu class dalam kalimat, gunakan
tag <SPAN>. Untuk itu anda harus
membuat dulu class-nya misalnya:
.big {font-size:14pt; text-
decoration:underline}

Kemudian masukkan class itu ke
dalam tag SPAN, seperti:

<<PP  ccllaassss==”” qquueessttiioonn”” >>  AAppaakkaahh<<SSPPAANN
ccllaassss==”” bbiigg”” >>  DDHHTTMMLL  <<//SSPPAANN>>  iittuu??
<<//PP>>. Contohnya dijelaskan pada
Langkah 3-4.

External Style Sheets adalah suatu
file yang berisi deklarasi tentang
suatu style dan diberi nama dengan
ekstensi .css. Untuk menggunakan-
nya, diperlukan tag <LINK> seperti
dijelaskan pada Langkah 5-8.

MASUKKAN FILE CSS DAN HTML
PADA SATU FOLDER
Selanjutnya simpan dokumen HTML
yang telah dibuat dalam satu folder
dengan file CSS-nya agar style sheet-nya
bekerja. 

PREVIEW DENGAN BROWSER
Sekarang uji dengan browser, dan
buktikan bahwa halaman Web anda
telah diberi sentuhan oleh file external
CSS yang telah di-link ke dalam
dokumen ini. Dengan cara ini maka
anda bisa mengubah semua dokumen
HTML dengan seragam dan cepat.

MENGGUNAKAN TAG SPAN
Jika anda ingin memasukkan suatu class dalam
paragraph class, gunakan tag <SPAN>. Pada
contoh ini, dibuat class baru: .big dengan
spesifikasi seperti gambar di atas. Lalu pada
paragraph class question, masukkan <SPAN
class=”big”>....</SPAN>. Sehingga dalam satu
kalimat, ada dua class yang berkerja.

PREVIEW DENGAN BROWSER
Sekarang buktikan dengan browser!
Terlihat pada pertanyaan di atas, ada dua
style sheet yang dimasukkan ke dalam-
nya. Pada frasa style sheet, bekerja
class big dan sisanya class question.

3

7 8

4

TIP & TRIK • TIP & TRIK • TIP & TRI

Beberapa Cara
Memasukkan Style ke
Halaman Web
1. Dengan menggunakan atribut

STYLE, misal <H1 STYLE=text-
align:center> Inline Style
Sheet</H1>

2. Melalui tag langsung <STYLE>
3. Melalui elemen <LINK> dengan

External Style Sheets.

!

Mengunakan Micosoft
FrontPage 2000

4..Sekarang klik nilai-nilai
yang tertera pada
window ini

5. Pada window Modify
Syle, anda telah mem-
format tag untuk
paragraph. Nilainya
dapat dilihat pada
bagian Description
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Internet, khususnya World Wide Web, tampil sebagai dunia yang misterius.
Banyak teknologi baru yang diciptakan dan diimplementasikan, sering kali
tanpa dokumentasi yang cukup. Dengan begitu banyaknya istilah-istilah
baru yang muncul setiap hari, banyak dari kita yang akhirnya kewalahan.

NDA TELAH MENGENAL HTML
dan sudah bisa membuat situs
Web sendiri. Adanya JavaScript

yang dapat di-copy-and-paste membuat
situs anda nampak lebih menarik. Peleng-
kap-pelengkap lainnya seperti hit counter,
guest book, chat room, dan bahkan e-
mail plug-in dapat anda tambahkan
untuk membuat situs anda lebih menarik.

Kini timbul keinginan membuat for-
mulir sendiri dan menyimpan data yang
masuk dalam bentuk database. Atau
ingin membuat situs Web anda dapat
diubah-ubah mengikuti gaya pengun-
jungnya. Kelemahan HTML ini mem-
buat situs yang ditulis hanya dengan
HTML tidak dapat dengan mudah di-
perbarui karena setiap pembaruan ber-
arti membongkar keseluruhan situs.

Hal inilah yang membuat server-side
technology menjadi populer.Yang paling
populer adalah CGI (Common Gateway
Interface) yang kebanyakan (tidak selalu)
ditulis dalam Perl. Kini sebagai pilihan
terhadap CGI terdapat pula teknologi lain
seperti ASP (Active Server Pages), JSP
(Java Server Pages), dan PHP. Bagaimana
kita membandingkan semuanya itu.

Teknologi Server
Sebelum kita membahas pelbagai tek-
nologi sisi-server ini, ada baiknya kita
bahas dulu server-nya. Apabila mem-
buat dokumen HTML, anda dengan
mudah dapat melihatnya dulu secara
offline dengan browser (client software).
Jika sudah cocok baru anda upload ke
server yang menjadi host dari situs
Web anda.

Tidak demikian halnya dengan halaman
web yang ditulis untuk sisi server. Anda
perlu melihat hasilnya setelah halaman
itu dipasang pada server, dengan cara
mengaksesnya lewat komputer client.Misal-
nya database pendaftaran mahasiswa ter-
dapat pada server. Komputer client yang
mengaksesnya dapat mengisikan record
dan men-submit ke server tempat record
itu terkumpul dalam bentuk database.

Untuk menguji dokumen yang anda
buat untuk server, anda dapat memasang
server sendiri yang akan berperan seba-
gai local host pada LAN anda. Misalnya
anda mempunyai dua atau lebih kom-
puter yang terhubung sebagai LAN, maka
salah satu dapat anda pasangkan server.
Dokumen sisi-server di simpan di sini
dan dapat diakses dari komputer lain,
misalnya dengan mengetikkan URL seperti
http://localhost (dapat saja satu komputer
sebagai server lokal dan client sekaligus).

Server yang paling populer di world
wide web adalah Apache yang berjalan
pada sistem operasi Unix, sedangkan
Microsoft tidak mau kalah dan menye-
diakan Information Server yang kini
sudah versi 5 (IIS 5) dan berjalan pada
Windows NT dan 2000. Adapun PWS
(Personal Web Server) adalah versi mini
IIS yang berjalan pada Windows 95/98/ME.
Apache selain di Unix tersedia juga
versi Windows dan dapat di-download
di http://httpd.apache.org/dist/httpd/
binaries/win32/

Microsoft PWS

Bila menggunakan Windows 95/98/ME
dan ingin mulai mempelajari teknologi

server gunakan saja PWS yang tersedia
pada CD Windows 98/ME. Download di:
http://www.studiodeluxe.net/pws/index.htm
PWS dibahas secara rinci pada nomor
ini di halaman 24–27.

Server Lain untuk Windows

Server lain untuk Windows di antara-
nya adalah Xitami (www.xitami.com) dan
Sambar (www.sambar.com). Keduanya
berukuran kecil sehingga cocok untuk
pemakaian pribadi dalam menguji script
yang dibuat. Sambar dan Xitami akan
dibahas pada kesempatan lain.

Tidak semua teknologi sisi server didu-
kung oleh setiap jenis server, sehingga
anda harus memilih-milih dulu sesuai
dengan apa yang akan digunakan. Server
asal Microsoft seperti PWS dan IIS jelas
mendukung DBMS dari Microsoft seper-
ti MS SQL dan MS Access serta tekno-
logi Active Server Pages (ASP). Apache
biasanya menggunakan MySQL (Windows)
atau MySQL/PostgreSQL (Linux).

CGI dan Perl
CGI adalah teknologi sisi server yang
paling populer. CGI atau Common
Gateway Interface adalah protokol
(cara melakukan sesuatu di web), bukan
bahasa pemrograman itu sendiri. CGI
adalah cara umum suatu server ber-
interaksi dengan program. Jadi suatu
program yang dibuat untuk bekerja
pada CGI harus mengirimkan data
mengikuti standar tertentu. Program
yang dipakai bisa apa saja, namun
yang paling populer adalah Perl (dan
kedua adalah C).

A

Dynamic Dynamic HHTTMMLL
Memahami SerMemahami Server dan Server dan Server-side Scriptingver-side Scripting
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Jadi bila orang mengatakan CGI script,
maka kebanyakan artinya adalah script
yang dibuat (kebanyakan tetapi tidak
selalu) oleh Perl. Perl itu sendiri adalah
bahasa pemrograman yang namanya
merupakan kepanjangan dari Practical
Extraction and Report Language.

Perl yang diciptakan pada tahun 1986
pada awalnya tidak dirancang untuk Web,
melainkan untuk membuat laporan per-
usahaan tempat pembuatnya, Larry Wall,
bekerja. Perl kini digunakan untuk banyak
hal, namun yang paling utama adalah
untuk membuat halaman Web menjadi
interaktif.Terdapat script untuk mengolah
formulir, membuat guestbook, membuat
bulletin board pada web, hit counter, dan
lain sebagainya.

Ada tiga alasan mengapa Perl popular
untuk menangani hal-hal yang berhu-
bungan dengan Web. Pertama, Perl
amat baik dalam memanipulasi teks.
Kalimat yang panjang dapat dengan
mudah diubah menjadi field-field dan
data (yaitu informasi yang dapat digu-
nakan, dikompilasi, dan disortir).

Kedua, Perl dapat dengan mudah dipin-
dahkan (ported) dari suatu platform ke
platform lain. Misalnya suatu script
yang ditulis pada Windows dapat dengan
mudah disalin ke sistem Unix atau
Macintosh tanpa (atau hanya dengan
sedikit) perubahan.

Ketiga, Perl merupakan bahasa yang
asik! Para programmer amat menyukai
Perl karena sifatnya yang semantis.
Suatu hal dapat mempunyai banyak
arti tergantung pada konteksnya. Ini
pula yang membuat Perl terkenal
sebagai bahasa yang sulit untuk pemula.

Belajar CGI perlu Apa?

Jika menggunakan Windows, anda
memerlukan server yang berjalan di
Windows: PWS, Xitami, atau Sambar.

Selain itu anda juga harus menginstal
Perl interpreter. Yang populer adalah
ActivePerl dari ActiveState. Download di
http://aspn.activestate.com/ASPN/
Downloads/ActivePerl/

Waktu anda menginstal Perl interpreter,
maka terinstalasi pula CGI.pm, suatu mo-
dul standar untuk membaca dan men-
jalankan (parsing) CGI Script. Namun
CGI.pm yang terpasang mungkin bukan
yang terbaru. Periksa di http://stein.cshl.
org/WWW/software/CGI/#installation

PHP dan MySQL
PHP pada awalnya adalah singkatan
dari ‘Personal Home Page.’ Diciptakan
pada tahun 1994 oleh Rasmus Lerdorf
untuk memonitor siapa saya yang me-
ngujungi situs web-nya dan membaca

resume online-nya. Kini PHP berubah
menjadi singkatan berulang: ‘PHP:
Hypertext Preprocessor.’ Secara har-
fiah dapat diartikan bahwa PHP
menangani data sebelum dijadikan
HTML. PHP adalah bahasa scripting
yang di-embed ke HTML dan dijalan-
kan di server. PHP juga bersifat cross-
platform seperti halnya Perl.

PHP adalah salah satu alternatif dalam
merancang situs web. Alternatifnya:

• CGI script yang ditulis (kebanyakan)
dalam Perl

• ASP (Active Server Pages), umum-
nya ditulis bersama VBScript

• JSP (Java Server Pages), umumnya
ditulis bersama JavaScript

Kelebihan PHP dibandingkan yang lain
adalah lebih cepat dan lebih mudah pem-
buatannya, demikian pula eksekusinya.
Lebih mudah karena tidak memerlukan
keterampilan pemrograman khusus.

Lebih jauh lagi, PHP yang memang lahir
belakangan, dirancang khusus untuk ha-
laman Web yang dinamis, sedangkan Perl
(juga VBScript dan JavaScript) tidak khu-
sus dirancang untuk itu. Namun PHP
lebih sederhana. Perl dapat melaksanakan
apa yang tidak dapat dilakukan oleh PHP.
Lebih lanjut lagi Perl lebih sederhana di-
bandingkan C atau Java.

Belajar PHP perlu Apa?

Pertama anda harus mempunyai server
yang mendukung PHP dan itu dapat di-
pasang di komputer sendiri. Biasanya
server yang digunakan adalah Apache:
http://httpd.apache.org/dist/httpd/binaries
/win32/

Download file dengan nama
apache_1.3.20-win32-src-r2.msi

File ini memerlukan Microsoft Installer
untuk dapat diinstal, yang dapat di-
download dari situs Microsoft di
http://www.microsoft.com/downloads/re
lease.asp?ReleaseID=17343

Kedua, anda memerlukan text processor
biasa. Pakai saja Notepad, Wordpad, atau
boleh juga Word, tapi text processor yang
baik membuat penomoran baris sendiri.
Di antaranya yang dirancang untuk edit
serta menguji hasilnya adalah PHPEd.
http://soysal.free.fr/PHPEd/PHPEdSetup3x.exe

PHP dan Database

Salah satu popularitas PHP adalah ke-
mampuannya mendukung berbagai
jenis database. Ini pula yang membu-
atnya lebih mudah dipelajari daripada
CGI Script.

Database adalah kumpulan table (tabel
terdiri dari kolom dan baris) yang me-

nyimpan informasi. Ada banyak server
database yang dikenal sebagai Database
Management System (DBMS) yang
berjalan di pelbagai macam platform.
Sekarang ini Oracle dipandang sebagai
database terbaik, tetapi pada Windows
dikenal SQL dan Access.

Database yang populer untuk dipakai
bersama PHP adalah MySQL
http://www.mysql.com/downloads/mysql-
3.23.html

Untuk memudahkan instalasi, kini sudah
terdapat PHPTriad yang bila diinstal
langsung menginstal komponen-kom-
ponen yang diperlukan untuk PHP.
Lengkap! Yang diinstal adalah:

• Apache server for Windows

• PHP dan PHPMyAdmin

• MySQL

Lihat PHPTriad dan PHPEd di hlm. 28–31.

ASP dan Database Microsoft
ASP adalah singkatan dari Active Ser-
ver Pages, suatu aplikasi yang berjalan
di IIS (Internet Information Service)
yang merupakan komponen yang
disertakan dalam Windows 2000,
untuk versi Windows sebelumnya ada-
lah PWS (Personal Web Server). ASP
setara dengan PHP atau JSP (Java
Server Pages) meskipun tidak sama
persis.

Semuanya merupakan script yang
dieksekusi di server, sehingga secara
otomatis untuk menjalankan file-file
ASP dibutuhkan sebuah server yang
mendukung ASP.

Untuk menjalankan IIS, anda harus
menggunakan Windows NT 4.0 ke
atas atau Windows 2000, sedangkan
untuk menjalankan PWS Anda harus
menggunakan Windows 95/98/ME

Selain berisi teks biasa, suatu file ASP
dapat juga berisi tag-tag HTML, XML,
dan script-script seperti JavaScript
dan lainnya.

Secara keseluruhan script ASP harus
diletakkan di server dan diproses di
server dan bukan di browser. Server
akan mengirimkan dokumen ke brow-
ser dalam bentuk HTML biasa, sehing-
ga pengakses file ASP tidak akan dapat
melihat script ASP dalam file tersebut.

ASP mendukung database Microsoft
seperti Access dan SQL. Bila ingin
menggunakan ASP dan Access tetapi
menginginkan server yang lebih ringan
daripada IIS atau PWS, gunakan saja
WebServer yang dapat di-download di
http://vwebserver.phidji.com NNTT
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icrosoft, yang diklaim seba-
gai raja software dunia, ha-
rus berjuang habis-habisan

menghadapi Linux yang kian hari
kian diminati.

Dalam bidang pemrograman Web,
Microsoft tidak mau ketinggalan,
client-side script-nya, VBScript
dikembangkan lagi menjadi sebuah
server-side script yang kemudian dina-
makan Active Server Pages (ASP).

Ini adalah upaya menandingi script
pemrograman CGI/Perl, dan teruta-
ma pula PHP (Personal Home Page—
Hypertext Preprocessor) yang lahir
dari basis Linux, meskipun kemudian
dapat pula dijalankan pada Windows.

M

2

8 9

3 4

10

CEK SEMUA KOMPONEN
Pilih komponen yang akan kita instal di
server. Tandai cek pada kotak kecil di
depan nama komponen. Jika telah ber-
tanda cek, biarkan. Jika belum, tandai
kotak di depannya. Pilih komponen
Personal Web Server (PWS) dengan
mengklik sekali pada namanya. Setelah
itu klik Show Subcomponents

TRANSACTION SERVER
Microsoft Transaction Server diinstal
di C:\Program Files\Mts. Klik Next
untuk melanjutkan ke langkah selan-
jutnya yang paling pokok, yaitu
Setup untuk mulai menginstal
PWS dengan komponen-komponen
yang telah kita pilih. Pantau
Instalasi pada Overal Progress.

SELESAI DAN JALANKAN
Klik Finish lalu restart komputer.
Untuk menjalankan PWS yang telah
kita Instal, pilih Start > Programs >
Microsoft Personal Web Server >
Personal Web Manager atau dengan
mengklik shortcut yang berada pada
dekstop anda. Maka jendela dialog
Personal Web Manajer akan muncul.  

INSTALASI BERJALAN
Setelah setup selesai menginstal PWS ke
PC kita, otomatis akan muncul jendela
dialog yang berisi pernyataan terimakasih
karena telah menggunakan Microsoft
Software. Proses Instalasi PWS selesai.
Klik Finish untuk keluar dari Setup, atau
dengan hanya menekan Enter pada
keyboard.

Instalasi PWS untuk persiapan belajar PHP dan ASP sekaligus!

PPEERRSSOONAL WNAL WEEB SB SEERVRVEERR
SSEERVRVEER GR GRRAATTIIS US UNNTTUUKK
WWIINNDDOOWWS DS DARARI MI MIICCRROOSSOOFFTT
Untuk bisa belajar membuat situs yang berisi guest book, formulir,
dan lainnya yang berhubungan dengan database, anda perlu
mengenal server-side scripting seperti PHP, ASP, dan CGI/Perl.
Tetapi sebelum itu harus mengenal server-nya itu sendiri. Untuk
Windows terdapat PWS yang merupakan IIS mini. Roswati S.
membahasnya untuk anda.

INSTAL PWS
Jalankan install.exe (atau setup.exe
jika menggunakan CD Windows 98).
Pada Windows dialog paling awal
disebutkan fitur-fitur yang disertakan
pada paket PWS: Personal Web Server,
Transaction Server, Data Access Com-
ponent, Message Queue Server Client,
dan Easy Administration. Klik Next .

MINIMUM, TYPICAL, CUSTOM?
Setelah menerima End User License, se-
lanjutnya pilih tipe Server yang akan
diinstal ke PC kita. Ada tiga tipe: Mini-
mum, Typical, dan Custom. Jika Anda
tidak mau repot pilih saja Typical. Pada
bahasan kali ini kita akan mencoba tipe
Custom. Klik tombol Custom dan
lanjutkan ke langkah selanjutnya.
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ASP dibuat sedemikian rupa sehingga
banyak sekali fungsi dan instruksi
yang dapat dilakukan tetap mudah
untuk dibuat, yakni dengan gaya
bahasa Inggris sederhana pada listing
programnya.

Kemudian untuk lebih mengukuhkan
lagi dominasinya Microsoft menam-
bahkan fasilitas PWS (Personal Web
Server) yakni sebuah server mini yang
dapat digunakan untuk menjalankan
script ASP di PC Anda.

Karena sifatnya yang server-side
scripting, ASP mutlak harus dijalan-
kan dengan bantuan sebuah server
yang mampu mengeksekusi script ASP.

Dan memang, sesuai tujuan Microsoft,
maka ASP ini dibuat sedemikian rupa
sehingga hanya bisa dijalankan dengan
IIS (Internet Information Server) atau
PWS (personal Web Server) yang
merupakan bagian dari IIS.

Untuk itu sebelum mempelajari ASP,
perlu kita instal dahulu PWS ke PC
kita.

Pada bahasan ini, kita akan mencoba
menginstal PWS secara langkah per
langkah. Penulis menggunakan
Windows 98 OS, karena kebanyakan
Sistem Operasi Windows yang
digunakan saat ini adalah Windows
98 ini.

5

11 12
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DOCUMENTATION
Selanjutnya tampil sub-subkomponen
Documentation. Ada tiga yang
semua harus dicek: Active Server
Pages, Common Documentation
Files, dan PWS Administrator’s
Document. Klik OK lalu OK dan
Next. Masing-masing kembali ke
jendela sebelumnya.

HOME DIRECTORY
Web Publishing Home Directory, folder
yang digunakan untuk menempatkan
file-file Web atau file-file ASP anda,
default-nya C:\inetpub\wwwroot .
Tidak usah diganti dulu. Langsung saja
klik Next yang berada di sebelah ka-
nan bawah dari Windows dialog untuk
melanjutkan ke langkah berikutnya.

PERSONAL WEB MANAGER
Perhatikan apakah server dalam
keadaan on atau off. On dicirikan
dengan adanya URL yang namanya
diambil dari nama komputer Anda,
misalnya http://kosasih. Di bawah-
nya terdapat tombol Stop, serta folder
tempat kita menempatkan file-file kita,
dalam hal ini c:/inetpub/wwwroot. 

HALAMAN AWAL PWS
Kita coba menjalankan situs kita, klik
link http://kosasih itu; otomatis IE akan
dibuka dan jika proses instalasi kita
benar maka akan tampil halaman web
berjudul  "Welcome To Microsoft Per-
sonal Web Server" dengan URL-nya:
http://kosasih/IISSamples/Default
/welcome.htm 

PPEENNUUTTUUPP
Jika sudah demikian, selamat!

PWS telah terinstalasi di komputer
anda. Sekarang Anda tinggal

menyimpan semua file-file ASP
maupun HTML ke folder

C:\inetpub\wwwroot.
Awas jangan salah simpan, dan untuk
memanggilnya dari browser gunakan

alamat sesuai URL
nama komputer Anda misalnya
http://komputerku/namafile.asp

(pada contoh ini
‘komputerku’ adalah ‘kosasih’)

Mudah kan?
Selanjutnya akan kita bahas cara

menggunakan PHP pada PWS yang
sudah kita instal ini.

Dengan demikian anda dapat belajar
ASP dan PHP sekaligus

1
DOWNLOAD PWS
Download PWS dari situs Microsoft:
http://www.microsoft.com/ntser
ver/nts/downloads/recommende
d/NT4OptPk/win95.asp atau anda
juga dapat mendownload dari
http://www.studiodeluxe.net/
pws/index.htm

TIGA SUBKOMPONEN PWS
Akan muncul jendela dialog berisi tiga
subkomponen Personal Web Server
(PWS). Cek semua: Documentation,
Personal Web Manager, dan Word
Wide Web Server. Setelah itu pilih sub-
komponen Documentation dengan
mengklik sekali pada namanya, lalu
klik tombol Show Subcomponents.
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embahasan kita kali ini ada-
lah cara belajar ASP dan PHP
sekaligus. Dalam hal ini rupa-

nya PHP (Personal Home Page–
Hypertext Preprocessor) lebih flek-
sibel, karena ternyata PHP bisa dija-
lankan di hampir semua server yang
ada, termasuk PWS-nya Microsoft. Jadi
kita ‘kan tidak perlu repot-repot meng-
instal dua server pada PC Jika sudah
menggunakan PWS, anda sekalian
dapat memasang PHP.

Pada dasarnya, ada cara manual yang
lumayan rumit yang harus dilaku-
kan untuk memasang PHP di PWS,
karena harus melibatkan Registry
Windows. Namun untungnya seka-

P

2
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10PILIH SEMUA KOMPONEN PHP
Pada jendela dialog “Select Component”
terlihat daftar komponen/modul PHP
yang dapat diinstal. Untuk lengkapnya,
cek saja semua opsi yang ada dengan
mengklik kotak kecil di depan masing-
masing opsi. Jangan sisakan satu pun!
Klik lagi Next untuk melanjutkan ke
langkah berikutnya.

INSTALASI BERJALAN
Selanjutnya “Start Installation.” Tekan
Next untuk untuk menginstalasi PHP.
Jendela dialog “Installing” akan muncul.
Dari sini kita bisa tahu sampai sejauh
mana Setup bekerja. Tidak ada yang
perlu anda lakukan. Kita hanya me-
nonton saja Setup yang menginstal
modul-modul PHP ke PC kita.

PROGRAM MANAGER GROUP
Mucul jendela dialog “Select Program
Manager Group.” Secara otomatis
Setup akan membuat suatu Group
yang terdapat pada Start Menu untuk
PHP EasyWindows Installer ini, secara
default PHP4. Klik Next lagi untuk
melanjutkan ke langkah berikutnya.

PHP Easy Windows Installer memudahkan instalasi PHP pada berbagai server, termasuk PWS

PPEERRSSOONAL WNAL WEEB SB SEERVRVEERR
MMEENNJJALALANANKKAN PAN PHHPP
PPADADA PWA PWS ANS ANDDAA

SHUTDOWN SEBELUM INSTALASI
Selanjutnya muncul jendela dialog
“Shutdown WebServer.” Setup memin-
ta kita men-shutdown PWS yang
sudah kita instal jika PWS tersebut
dalam keadaan ON sebelum kita me-
lanjutkan langkah-langkah instalasi.
Untuk itu jika PWS Anda masih dalam
keadaan running, segera distop deh. 

KLIK STOP UNTUK SHUTDOWN
Klik icon Personal Web Manager yang
di dekstop dan pada Windows Dialog
Personal Web Manager lihat, apakah
PWS dalam keadaan running atau tidak?
Jika yang terlihat tombol ber label Stop"
artinya PWS sedang running, Stop dengan
mengklik tombol Stop tersebut. Tombol
Start berarti PWS sudah shutdown. 

Apa jadinya kalau ingin mempelajari ASP dan PHP sekaligus? Jika ingin
mempelajari ASP jelas harus memakai PWS atau IIS sebagai server-
nya, yang merupakan produk Microsoft juga. ASP yang asli “tidak mau
jalan” di server lain. Kecuali yang telah diadopsi, seperti Apache-ASP
misalnya, yang ditulis dengan bahasa Perl seperti CGI sehingga
berjalan di Apache Server.

UPGRADE ATAU INSTAL BARU?
Selain meminta Shutdown PWS, kita
juga diminta menghapus seluruh kom-
ponen PHP yang pernah kita instal, jika
kita hendak meng-upgrade PHP kita.
Anggap saja kita baru pertama kali me-
makai PHP. Kalau pernah menggunakan
PHPTriad sebelumnya juga tidak perlu
dihapus. Klik Next ke langkah berikutnya.
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rang ini sudah ada perangkat lunak
bantu yang dapat memasangkan PHP
ke PWS yang telah kita instal di PC,
tanpa harus berurusan dengan regedit
lagi. Software inilah yang akan jadi
bahasan kali ini.

Software ini PHP EasyWindows
Installer, buatan PHP every Where
(http://php.weblogs.com/easywindows).
Seperti halnya perangkat lunak lain
yang terkait dengan PHP, software
inipun berlisensi gratis alias boleh
dipakai bebas.

Untuk men-download-nya kunjungi
alamat tersebut di atas. Download
langsung dengan mengklik link yang
bertuliskan MMaaiinn  DDoowwnnllooaadd  SSiittee.

Atau pada browser langsung masuk-
kan URL berikut untuk men-download
software ini:

hhttttpp::////pphhpplleennss..ccoomm//ddll//pphhpp440044..EEXXEE

Apabila anda report men-download
dari Internet, gunakan saja CD NeoTek
untuk menginstalnya.

5

11 12
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BACKUP OTOMATIS
Software ini telah dilengkapi fasilitas
BackUp. Artinya jika dalam instalasi
nanti ada file atau folder yang terpak-
sa harus di-remove, maka file atau
folder itu akan secara otomatis disim-
pan dalam folder BackUp. Sewaktu
kita menguninstall software ini maka
secara Setup akan mengembalikan file
maupun folder tadi ke tempat semula.

13
HALAMAN AWAL PWS
Buka Internet Explorer, lalu ketikkan
URL berikut pada Address Bar IE:
http://komputerku/scripts/php/test.
php. Pada komputer anda ‘kompu-
terku’ akan mengambil nama kom-
puter anda. Tekan Enter. Jika semua-
nya benar yang muncul adalah kete-
rangan tentang PHP 4.0.4.

1
INSTALASI PHP404.EXE
Klik dua kali ikon php404.exe yang
baru saja kita download. Akan
muncul jendela dialog "Welcome."
Langsung klik tombol Next untuk
melanjutkan ke langkah berikutnya.

TEMPAT MELETAKKAN FILE PHP
Selanjutnya jendela dialog Choose
Destination Location,  Setup akan
menawarkan di mana menempatkan
modul-modul PHP (bila menggunakan
server non-MS, PHP harus diinstal di
direktori cgi-bin). Untuk contoh ini
biarkan saja pada keadaan default-
nya. Klik Next ke langkah selanjutnya.

PILIH ‘YES’ UNTUK BACKUP
Secara default, Setup akan membuat
BackUp dengan dipilihnya item “Yes.”
Untuk saat ini biarkan pilihan default-
nya, yaitu Yes. Untuk nama maupun
tempat folder BackUp juga biarkan
pada posisi default. Selanjutnya klik
Next untuk ke langkah berikutnya.

INSTALASI SELESAI, RESTART!
Muncul jendela dialog “Win9X
Instructions.” Klik Next untuk
menuju jendela dialog terakhir,
“Installation Complete.” Klik Finish
Muncul permintaan restart. Ya, klik
Yes untuk me-restart agar Windows
melakukan Update terlebih dahulu
pada sistemnya.

Jika menggunakan Windows 95, maka
sebelumnya Anda harus menginstall DCOM95.exe
yang bisa di-download di
http://download.microsoft.com/
msdownload/dcom/95/x86/en/dcom95.exe

EDIT DIRECTORY
Jalankan lagi PWS dengan mengklik
Start. Setelah itu, pada menu kiri jen-
dela dialog Personal Web Manager klik
Advanced. Tampil jendela “Advanced
Options.” Pilih folder Scripts, lalu klik
Edit Properties. Muncul jendela
dialog dengan tiga opsi: Read, Execute,
Scripts. Check ketiganya. OK.



28 NeoTek Desember 2001

NeoTutor

nda tidak perlu mencari
web hosting khusus untuk
membuat dan menguji

server-side script anda seperti
misalnya PHP ataupun Perl.

Kini dengan PHPTriad anda bisa
menginstalasi Apache server (yang
beken di Unix itu)dan berjalan pada
LAN anda (atau boleh juga cuma
stand alone) dan sekaligus memper-
oleh kemampuan PHP pada server
itu maupun database management
system mySQL

Semua berjalan baik pada Windows
95/98/ME. Hapus kesan rumit dan
sulit mengenai server-side scripting!

A

MENGAKTIFKAN MYSQL
Masuk ke c:\apache\mysql\bin
dan cari file winmysqladmin. Klik
dua kali file ini untuk mengaktifkan
MySQL. Jendela WinMSQLAdmin
akan tampil sebentar lalu hilang,
tetapi kini WinMySQL sudah aktif.

4
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IDENTIFIKASI LOCAL HOST
Pada layar ini perhatikan Local Host
Name (diambil dari identifikasi
komputer anda pada LAN) serta
Local IP Address, yaitu IP Address
lokal pada LAN anda. Dalam hal ini
komputer pada LAN yang dipasangi
server adalah KOSASIH dan Local IP
Address-nya 192.168.123.100

MYSQL SUDAH AKTIF
Tanda bahwa WinMySQL sudah aktif
terlihat pada bagian kanan bawah
layar dengan adanya ikon lampu
lalu-lintas yang menyala hijau.
Biarkan saja, kini kita harus
mengaktifkan Apache server-nya.
Pada direktori c:\apache cari file
bernama Apache (gambar bulu).

SAVE SEBAGAI PERTAMA.PHP
Save skrip PHP tadi di folder
c:\apache\htdocs dengan nama,
misalnya, pertama.php
Pilih Save as type: All files (*.*),
jangan pilih Text Documents sebab
nanti nama file-nya jadi aneh seperti
pertama.php.txt

SKRIP LAINNYA
Kita coba skrip sederhana yang lain
lagi sebagai berikut:
<?
phpinfo();
?>
lalu save sebagai phpinfo.php
juga di c:\apache\htdocs

MENJALANKAN SCRIPT PHP
Untuk menjalankan skrip PHP, pada
browser panggil skrip ini dengan
http://localhost/pertama.php atau
dalam hal ini dapat juga dengan
http://kosasih/pertama.php. Anda
telah berhasil membuat dan menguji
script PHP anda yang pertama baik
pada server maupun client!

PHPTriad solusi ‘three in one’ untuk belajar server-side scripting

PPHHPTPTRRIADIAD
CCARARA MA MUUDDAH BAH BEELLAAJJARAR
APAPAACCHHE, PE, PHHP, DP, DAN MAN MYYSSQLQL
Bagi pengguna Windows, PHP, Apache, dan MySQL terdengar
sebagai istilah asing. Padahal kini anda sudah bisa menginstal
Apache server, PHP dan database MySQL pada Windows
dengan satu kali klik.
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MENGAKTIFKAN APACHE SERVER
Klik ikon bulu tadi dan akan muncul
konsol DOS yang menyatakan bahwa
kini server Apache sudah berjalan:
Apache/1.3.14 (Win32) running...
Nah, sekarang anda sudah siap
untuk mengetikkan dan menguji
skrip PHP anda!

MEMASTIKAN SERVER BERJALAN
Untuk memastikan bahwa server ini
sudah berjalan, buka browser dan
masuk ke http://localhost maka
akan tampil layar informasi menge-
nai PHPTriad pada browser anda.
Pada komputer lain dalam LAN
dengan mengetikkan nama local
host, dalam hal ini http://kosasih

FILE PHP YANG PERTAMA
Gunakan Notepad untuk membuat
skrip PHP anda yang pertama. Skrip
PHP selalu dimulai dengan
<?php dan diakhiri dengan ?>.
Jadi ketikkan sebagai berikut:
<?php
print (“Script PHP pertama”);
?>

JALANKAN PADA BROWSER
Dari browser panggil dengan menge-
tikkan http://localhost/phpinfo. php
atau dalam contoh ini dapat juga
dengan http://kosasih/phpinfo. php
dan akan tampil halaman informasi
mengenai versi PHP yang berjalan
pada komputer anda yang kini ber-
tindak sebagai server Apache ini.

SKRIP PHP DI ANTARA HTML
Anda dapat juga menyisipkan tag-tag
PHP pada dokumen HTML. Pada
contoh ini judul halaman ini adalah
‘Uji script PHP’ yang dituliskan di
antara <TITLE>…</TITLE>. Namun
file ini tetap harus di-save dengan
ekstensi php, misalnya info.php

PHP INFO PADA HALAMAN WEB
Hasilnya serupa dengan phpinfo.php,
yaitu menampilkan informasi ten-
tang versi PHP yang berjalan, hanya
kini pada bagian bar atas browser
terlihat nama file ini yang diketik-
kan dengan menggunakan tag-tag
HTML. Kini anda sudah bisa belajar
dan menguji sendiri skrip PHP!

1 2 3
INSTALASI
Klik dua kali ikon phptriadsetup2-11
dan instalasi akan dimulai. Ikuti
langkah-langkah installation wizard
ini sampai selesai. Instalasi ini pada
dasarnya akan mengekstrak file-file
ke suatu direktori khusus, yaitu
c:\apache

DOWNLOAD PHPTriad
Di kotak Search www.download.com
ketikkan ‘PHPTriad’ untuk PC dan
klik ‘Go.’ Anda akan masuk ke
halaman download PHPTriad dari
situs ini. Klik ‘PHPTriad 2.11’ untuk
men-download phptriadsetup2-11

APACHE, PHP, DAN MYSQL
Tampak di bawah folder Apache ter-
dapat berbagai folder lain, di antara-
nya folder-folder PHP dan MySQL.
Itulah ‘triad’ nya. Sekali klik anda
menginstal tiga komponen penting:
server (apache), scripting tool (PHP),
dan database (MySQL).
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ukan hanya untuk PHP,
PHPEd juga amat memu-
dahkan pembuatan script

untuk Perl, Python, maupun Java-
Script. Juga untuk DHTML, lengkap
dengan meta tag dan CSS-nya.

Selain mempunyai fasilitas auto-
complete yang mempercepat, me-
mudahkan, dan mencegah kesalahan
ketik skrip, PHPEd juga memung-
kinkan kita menguji skrip yang kita
buat tanpa harus khusus meng-
instal server.

Manfaatkan PHPEd bersama
PHPTriad. Keduanya menjadi alat
bantu scripting yang canggih.

B

MEMULAI PHPEd
Tutup jendela “Project Properties”
dengan mengklik OK atau tanda
silang di bagian kanan atas jendela
itu dan kita siap menggunakan
PHPEd untuk membuat skrip kita,
baik itu skrip PHP, HTML, Perl,
ataupun Python. Pada contoh ini
kita gunakan contoh PHP.
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MEMBUKA FILE BARU
Buka file baru dengan memilih File
→ New. Akan tampil jendela yang
menampilkan jenis-jenis file yang
dapat dibentuk/diedit dengan
PHPEd: HTML, Perl PHP, SQL,
Python, dan JavaScript. Kita pilih
PHP file.php dengan mengklik ikon-
nya dua kali (double click).

JENDELA PHP EDIT
Tampil jendela “Editor PHP” dengan
nama NONAME1.PHP. Tag pembuka
dan penutup PHP sudah disediakan.
Kini anda tinggal mengetikkan skrip
PHP anda di antara kedua tag PHP
itu. Sebagai editor skrip yang baik,
PHPEd menyediakan nomor baris
untuk memudahkan penulisan skrip.

MENGUJI SKRIP TANPA SERVER
Salah satu kelebihan PHPEd adalah
bahwa kita dapat menguji server-
side script tanpa harus menginstal
server itu sendiri. Pilih Tools →
Settings dan jendela “Properties”
akan ditampilkan. Pilih tab “Server”
pada jendela ini.

MENGUBAH PARAMETER
Kita ubah parameter Executable agar
terhubung ke direktori kita. Caranya
klik tombol Edit di sebelah kanan
ekstensi file dan akan tampil jendela
“Associate extensions.” Klik tanda
folder terbuka pada jendela ini dan
akan tampil jendela lain lagi yaitu
“Select Executable.”

PARAMETER DEFAULT
Setelah memilih tab Server pada jen-
dela Properties ini akan tampak pa-
ramater-parameter default yang di-
gunakan oleh PHPEd, yaitu Server
Port: 8080, Home Directory, dan
Default Documents. Adapun file
extension .php dapat dieksekusi
(executable) dari c:\php\php4isapi.dll

PHPEd memungkinkan pengujian server-side script tanpa server

PPHHPPEEDD
EEDDIITTOOR CR CANANGGGGIIH UH UNNTTUUKK
PPHHP, PP, PEERRL, HL, HTTMML & PL & PYYTTHHOONN
Pembuatan script dapat dilakukan dengan menggunakan Notepad
atau text processor lain, tetapi script editor yang baik selain
memberi penandaan baris juga mempunyai fasilitas-fasilitas lain
untuk memudahkan pembuatan dan pengujian script. Pada PHPEd,
malah pengujian tidak perlu dilakukan dengan menginstal server!
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FASILITAS AUTOCOMPLETE
Kita buat file PHP sederhana yang
berisi satu pernyataan, yaitu phpinfo().
Terlihat bahwa waktu kita mengetik-
kan skrip PHP, apabila kita diam
sebentar maka akan tampil pilihan-
pilihan keyword yang mungkin. Fa-
silitas autocomplete ini membantu
mengurangi kesalahan ketik.

SAVE SEBAGAI PHPINFO.PHP
Pilih Save → Save As… dan
jendela Save As akan ditampilkan.
Save file ini dengan
File name: phpinfo, 
File type: PHP files,
dan File Format: Windows
di direktori c:\apache\htdocs

BUKA DI BROWSER
Buka browser, lalu ketikkan
http://localhost/phpinfo.php
atau pada contoh ini dapat juga
http://kosasih/phpinfo.php
Untuk anda tentunya tergantung
pada nama identifikasi komputer
yang digunakan sebagai server pada
LAN.

UBAH PATH/FILENAME
Pada kotak path/filename, ubah:
c:\apache\php\sapi\php4isapi.dll
Kemudian klik “Open.” Tampil lagi
jendela “Associate Extension” dengan
path/filename yang sudah diubah.
Klik OK lagi di sini. Kembali ke jende-
la “Properties” dengan path/filename
baru dan klik OK juga.

BUKA DAN RUN PHPINFO.PHP
Pada PHPEd pilih File → Open lalu
buka file phpinfo.php yang tersimpan
pada direktori c:\apache\htdocs. File
phpinfo.php ini akan dibuka dan siap
diedit, tetapi kita tidak akan meng-
edit, melainkan menjalankannya di
dalam PHPd itu sendiri tanpa perlu
browser maupun server.

PHP INFO PADA HALAMAN WEB
Pilih Run → Run dan PHPEd Srv akan
diaktifkan serta akan tampil jendela
“Output” yang merupakan tampilan
untuk skrip PHP ini. PHPEd Serv ini
bertindak sebagai server (tampak
ikon bola dunia di sebelah kanan ba-
wah layar). Kini untuk menguji skrip
PHP anda tidak perlu server khusus!

1 2 3
INSTALASI
Klik dua kali ikon PHPEdSetup3x.exe
dan instalasi akan dimulai. Pilih full
installation dan ikuti installation
wizard ini sampai selesai. Software
ini secara default akan diinstal di
c:\Program Files\PHPEd, dengan
program group PHPEd

DOWNLOAD PHPEd
Masuk ke home page PHPEd di
http://soysal.free.fr/PHPEd/ dan
download PHPEdSetup3x.exe dari
situs ini. Ada banyak mirror site
yang dapat digunakan untuk men-
download perangkat lunak ini

JALANKAN PHPEd
Pilih Start → Programs → PHPEd →
PHPEd untuk menjalankan script
editor ini. Akan tampil dua jendela
yaitu “PHPEd” dan “Project Proper-
ties.” Untuk sementara kita tidak
gunakan dulu Project Properties ini.
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Makin banyak orang berpaling ke Linux. Onno W. Purbo membuka
rahasia penginstalan Linux yang ternyata tidak sulit dilakukan.

LINUX ADA-
LAH SISTEM
OPERASI di
PC yang
dapat di-
copy secara
bebas dan
tidak me-

langgar hak cipta. Saat ini
Linux sudah banyak terse-
dia di toko-toko komputer.
Ada beberapa pilihan distri-
busi Linux, seperti, Caldera,
Red Hat, Mandrake, Debian,
Slackware dll. Dalam contoh
saya akan menggunakan dis-
tribusi Mandrake 8.0 yang
ternyata paling mudah diin-
stal dan dioperasikan diban-

dingkan distribusi yang lain.
Memang Mandrake 8.0 ka-
dang ada kelemahannya ter-
utama dalam mendeteksi
periferal (I/O) terutama
pada laptop atau notebook,
sehingga saya harus meng-
edit secara manual setting
beberapa periferalnya.

Dalam tulisan ini saya akan
mencoba menjelaskan tek-
nik instalasi Linux di PC.
Secara umum ada beberapa
pilihan cara instalasi yang
dapat dilakukan, pada
kesempatan ini saya akan
fokuskan pada PC dengan
dua sistem operasi (Linux
dan Windows) agar dapat

beroperasi secara berganti-
an. Ada dua skenario dalam
melakukan instalasi dual OS
ini, yaitu:

• PC sudah terinstalasi
Windows. Seluruh
harddisk sudah terformat
menggunakan Windows
file system FAT32.

• PC sama sekali belum
terinstalasi apa-apa, kita
mulai dari nol. Seluruh
harddisk masih kosong
dan belum terformat
sama sekali.

Tentunya jika anda ingin
menginstal hanya Linux sa-
ja, urusan jadi lebih gam-

pang karena tinggal menim-
pa semua harddisk dengan
Linux.

• Pastikan anda masih me-
miliki sisa harddisk mini-
mal sebesar 1.5GB untuk
Linux. Tidak apa-apa jika
harddisk tersebut sudah
terformat menggunakan
Windows FAT32, kita bisa
mengakali agar file system-
nya nanti diubah menjadi
ext2 yang digunakan Linux.

• Catat baik-baik semua
data teknis periferal yang
ada di komputer yang anda

gunakan, seperti, ethernet
card (LAN card), sound

card, jenis harddisk, video
card. Umumnya Linux
Mandrake secara otomatis
mendeteksi card-card ter-
sebut. Ini hanya untuk ber-
jaga-jaga kalau Mandrake
gagal mendeteksi card
periferal. Cara paling se-
derhana dan mudah untuk
mencek data teknis peralat-
an (card periferal) yang
digunakan adalah menggu-
nakan Windows melalui
Start ! Settings! Control

Panel ! System !Device
Manager. Klik device yang
anda inginkan dan catat
resources yang digunakan.

• Setting BIOS diubah agar
urutan booting menjadi
FDD (floppy) ! CDROM
! HDD (harddisk). Untuk
memasuki setting BIOS te-
kan ESC atau DEL pada sa-
at booting pertama kali dan
cari bagian untuk setting
urutan booting.

CarCara Pra Praktis aktis 
Menginstal LinuxMenginstal Linux

• Tampilan layar Linux Mandrake 8.0

yang beroperasi di bawah Gnome.

SSeebbeelluumm  MMeennggiinnssttaall  LLiinnuuxxSSeebbeelluumm  MMeennggiinnssttaall  LLiinnuuxx
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BAGIAN
INI ME-
RUPAKAN
bagian
yang
paling
seru,
merupa-

kan seni tersendiri dan
sangat bergantung pada
kebutuhan kita maupun
kondisi awal harddisk yang
akan diinstal. Minimal se-
kali Linux membutuhkan
partisi:

Ada beberapa cara melaku-
kan partisi harddisk untuk
Linux, tergantung pada:

• Apakah di harddisk anda
sudah ada Windows-nya
atau belum.
• Apakah anda ingin meng-
gunakan seluruh harddisk
tersebut untuk Linux atau
hanya sebagian saja.
Jika di harddisk anda sudah
terinstal Windows dan se-
luruh harddisk sudah ter-
format dengan Windows
file system FAT32. Maka:
• Jalankan scandisk pada

harddisk anda. Melalui
Start!"Programs !
Accessories ! System
Tools ! ScanDisk.

• Jalankan defraq pada
harddisk anda. Melalui
Start! Programs !
Accessories!
SystemTools ! Disk
Defragmenter.

• Install software Partition
Magic pada harddisk an-
da. Software ini dapat de-
ngan mudah diperoleh di
toko komputer terutama
di Glodok atau Mangga
Dua dan termasuk kate-
gori utility software.

• Jalankan partition magic
dan ubah ukuran partisi
Windows. Langkah yang
harus dilakukan
sebetulnya sederhana
saja, yaitu:
# Resize partisi C:

secukupnya untuk
sistem Windows. Sa-
ya biasanya membe-
rikan sekitar 1,5
Gbyte. Pada partisi
sisa sudah kosong,
kita bagi untuk
beberapa partisi.

# Alokasikan sekitar
1.5-2Gbyte untuk
Linux menggunakan

file system ext2, jika
mungkin di set
sebagai primary
partition (bukan
logical partition).
Partisi ini nantinya
akan di mount pada /.

# Alokasikan untuk
/home pada Linux
menggunakan file
system ext2. Saya
biasanya
mengalokasikan
sekitar 500Mbyte-an
agar StarOffice dapat
dimasukan dengan
mudah.

# Alokasikan untuk
swap Linux menggu-
nakan file system
Linux swap. Saya
biasanya mengaloka-

sikan jumlah yang
sama dengan memory
(RAM) yang ada
sekitar 64 Mbyte.

# Seluruh sisa partisi
yang masih ada bia-
sanya saya alokasikan
untuk logical parti-
tion untuk data. Bia-
sanya saya menggu-
nakan Windows file
system FAT32 dan
dikenal di Windows
dengan drive D:

Setelah seluruh proses re-
partisi selesai dilakukan
mengunakan Partition Ma-
gic, maka akan tampak la-
yar Partition Magic kira-
kira seperti pada gambar.
Pada gambar adalah contoh
partisi yang ada di kompu-
ter notebook saya, Toshiba
Tecra 8000, dengan hard-
disk 12Gbyte dan RAM
64Mbyte yang sudah diins-
tal Windows 98 yang asli
bawaan notebook tersebut
dan Linux Mandrake 8.0
yang saya instal kemudian.

Jika anda cukup beruntung
dapat menginstall Windows
dan Linux dari awal (hard-
disk kosong), maka cara
yang paling sederhana agar
dapat dual boot adalah:

• Boot melalui startup disk
atau CD source windows.
Startup disk dapat dibuat
sendiri dari Windows me-

lalui Start ! Settings!
Control Panel !"Add/
Remove Program! Start-
up disk.
• Gunakan fdisk dari prompt
A: (jika menggunakan
startup disk) untuk mem-
buat partisi Windows secu-
kupnya, misalnya 1.5Gbyte
untuk C:, beberapa Gbyte
untuk D:. Jangan habiskan
semua harddisk di partisi
menggunakan fdisk, sisa-
kan secukupnya (2-2.5
Gbyte) untuk Linux. Fdisk
tidak dapat digunakan un-
tuk mempartisi bagian Li-
nux, karena fdisk hanya
mengenal file system FAT32
(Windows), tapi tidak ext2
Linux. Jadi sisa hardisk
yang akan dipartisi untuk
Linux kita diamkan saja,
jangan dipartisi oleh fdisk.
• Aktifkan partisi C:
• Keluar dari fdisk dan
booting ulang mesin.
• Lakukan perintah format
C: dan D:, dan instal Win-
dows beserta semua pro-
gram yang anda butuhkan
di Windows, seperti Office,
Winzip, Adobe Acroread dll.

Linux baru dapat kita instal
setelah semua software
Windows sudah diinstal di
harddisk agar kita dapat
melakukan dual boot
dengan dua sistem operasi.

MMeennyyiiaappkkaann  PPaarrttiissii  uunnttuukk  LLiinnuuxxMMeennyyiiaappkkaann  PPaarrttiissii  uunnttuukk  LLiinnuuxx

Directory Mount File System Ukuran

/ Ext2 1 Gbyte

/home Ext2 100Mbyte

swap Swap 64Mbyte
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MASUKKAN CD LINUX MAN-
DRAKE (CD 1) KE CD drive dan
boot komputer. Setel BIOS
agar urutan booting berlaku
sebagai berikut:
FDD (floppy) ! CDROM
! HDD (harddisk).

Proses instalasi Linux, terutama bagi yang
dengan Mandrake 8.0, sudah demikian
mudah. Sebagian besar parameternya sudah
berjalan otomatis. Anda tinggal mengklik
untuk meng-OK-kan saja. Di samping itu,
sebagian parameter dapat di-set ulang
setelah Linux Mandrake terinstal dengan
menggunakan fasilitas Mandrake Control
Center. Anda tidak akan mengalami
kesulitan berarti dalam menginstal Linux.

MMEENNGGIINNSSTTAL LIAL LINNUUXX
DDEENNGGANAN
MANMANDDRRAKAKE 8.0E 8.0
Distribusi Linux Mandrake 8.0 tidak sulit untuk diinstal di
komputer anda karena program ini telah dibuat dapat
mendeteksi periferal yang terdapat pada komputer anda.

Kelanjutan instalasi
Bagi anda yang beruntung me-
miliki CD 1 dan 2 dari Mandrake,
maka proses instalasi paket soft-
ware dapat dilanjutkan ke CD 2,
setelah CD 1 terinstal. Waktu
instalasi tergantung pada CD
drive dan komputer anda.

User password
Setelah semua software diinstal,
akan ditanyakan password untuk
root (user tertinggi) di mesin anda.
Jangan sampai lupa password
root. Informasi user lain dapat
dimasukkan secara bertahap
satu per satu secara manual.

Recommended atau expert?
Mandrake memberikan pilihan
apakah menginstal software yang
recommended saja, atau untuk
expert (ahli). Pada pilihan
recommended hanya software
yang diperlukan saja yang akan di
instal. 

Periferal & security level
Untuk men-set beberapa periferal
(SCSI, mouse, keyboard), pilih
pilihan default. Selanjutnya pilih
level keamanan ‘low’ jika anda
tidak banyak tersambung ke
Internet atau berada di balik
firewall.

4

10 11

5

Menginstal Mandrake 8.0 di komputer anda

Partisi harddisk
Selanjutnya partisi. Jika partisi telah
disiapkan sebelumnya, gunakan
partisi yang ada. Jika belum, proses
partisi sangat di bantu oleh inter-
face grafik yang ada. Untuk pilihan
recommended, biasanya proses
partisi sangat mudah. 

6

Sambungan ke Internet
Selanjutnya menset sambungan
ke Internet. Biasanya kita akan
memilih normal modem connect-
ion dan memasukkan nomor tele-
pon, username dan password un-
tuk berhubungan ke Internet me-
lalui ISP. Pada LAN dapat dipilih
LAN untuk nyambung ke Internet.

12
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3 Lisensi software
Selanjutnya anda diminta meneri-
ma perjanjian lisensi penggunaan
software. Anda dapat membaca-
nya baik-baik dan jika anda men-
erima perjanjian tersebut, tekan
tombol ‘Accept.’

NeoTekno

Format partisi harddisk
Setelah partisi harddisk selesai
dilakukan, selanjutnya format partisi
harddisk yang telah di set untuk file
system Linux ext2.

Menginstal paket program
Paket program diinstal untuk peng-
gunaan workstation, server atau
development. Masing-masing mem-
butuhkan software berbeda. Coba
instal sebanyak mungkin software
agar dapat mencoba berbagai hal
yang berkaitan dengan Linux. 

Pilihan instalasi
Jika anda ingin memilih pilihan
yang lain dalam cara menginstal,
anda dapat menekan tombol F1
sebelum menekan Enter.
Beberapa pilihan akan muncul.

Pilihan bahasa
Layar pertama yang muncul me-
nanyakan bahasa apa yang ingin
anda gunakan dalam operasi
Linux. Selain Inggris, bahasa
Indonesia  disediakan juga di
Linux Mandrake.  Tekan tombol
OK untuk melanjutkan.

1

7 8

2

Paket individual
Jika perlu beberapa software yang
lebih spesifik, anda dapat memilih
masing-masing paket software se-
cara individual (bukan secara grup).
Biasanya ada penjelasan singkat
dari software tersebut di kolom
sebelah kanan.

9

Menset servis Linux
Setelah mereview beberapa para-
meter seperti time zone, selanjut-
nya kita dapat menset servis apa
saja yang akan dijalankan oleh Li-
nux pada saat booting. Di sini kita
bisa menset Linux agar dapat ber-
komunikasi dengan Windows.

Membuat boot disk
Seperti halnya Windows, pada
Linux disediakan juga fasilitas
untuk membuat boot disk. Hal ini
dilakukan setelah kita diberi ke-
sempatan untuk menset servis
yang dioperasikan pada saat
booting.

13 14 Konfigurasi dual boot
Selanjutnya bagian yang cukup
kritis untuk proses dual boot PC.
Konfigurasi software bootloader
diset pada bagian ini. Biasanya
langsung saja di klik OK.

15
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Kelanjutan instalasi
Setelah bootloader, selanjutnya
kita diberi kesempatan untuk
menset parameter sistem operasi
yang akan di-boot. Juga bila di-
butuhkan kita dapat menambah,
sistem operasi yang akan di-
boot.

Ujung proses
Selanjutnya disodorkan pilihan
untuk menset layar monitor,.
Biasanya semua sudah di set
oleh DrakX. Jika semua proses
berjalan baik, pada saat dites
tampilan X-nya tampak gambar
pinguin di layar. Klik OK.

16

17

Instalasi selesai
Selesai sudah semua proses
instalasi. Selanjutnya, kita dapat
memilih apakah nanti pada saat
re-booting akan langsung menja-
lankan X-windows atau text
mode.

18

MMEENNYYEETTEEL L 
SSIISSTTEEM OM OPPEERRAASSII
MANMANDDRRAKAKE 8.0E 8.0
Agar Linux dapat berjalan dengan mulus di komputer anda,
anda perlu menyetel beberapa parameter Linux. Ikuti caranya
lewat uraian langkah per langkah di bawah ini.

Menyetel Linux agar dapat berjalan benar di komputer anda

3 Sambungan Internet
Untuk men-set Network dan In-
ternet Connection, klik Configure
untuk mengatur interface dimak-
sud. Kadang Mandrake tidak ber-
hasil mendeteksi modem/ethernet
card. Biasanya Mandrake dapat
mendeteksi berbagai card
interface secara otomatis.

Men-set mode lain
Setelah Network dan Internet,
Boot Config merupakan bagian
menarik yang kadang perlu di-set.
Kita bisa men-set boot mode,
system mode dan Linux Loader
(LILO) mode. Semua tinggal klik
saja.

4

Fungsi di background
Berbagai servis yang berjalan di
background dapat di-set pada
System→ Services. Servis ini teruta-
ma penting jika kita beroperasi
sebagai server. Kita dapat menset
apakah servis tersebut akan dijalan-
kan pada waktu boot, status servis,
di-start atau di-stop.

8 Font Windows untuk Linux
Font pun perlu diset untuk pe-
kerjaan yang berkaitan dengan
Office agar di-support Linux. Jika
anda gunakan dual boot Windows
dan Linux di satu harddisk, anda
tinggal mengklik menu ‘Get Win-
dows Fonts’ untuk mengimpor
font Windows ke Linux.

9
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Setelah Linux terinstal
di harddisk, langkah
selanjutnya yang perlu
dilakukan adalah
menset agar Linux
dapat beroperasi
dengan baik & benar.
Pada Linux Mandrake

proses setting berbagai hal tentang
sistem operasi Linux sudah sangat
dimudahkan & sebagian besar sudah
dapat di set menggunakan Graphical
User Interface (GUI). Lokasi berbagai
fasilitas konfigurasi sebetulnya ada di
Start → Configuration.

Masalah keamanan
Selanjutnya security. Untuk server
yang tersambung ke Internet ada
baiknya security level dipilih high.
Fasilitas lain yang bermanfaat ada-
lah Firewall. Hati-hati dengan fasilitas
ini karena jika di aktifkan maka fasili-
tas Samba/Network Neighbourhood
tidak bisa beroperasi.

Mengakses MCC
Fasilitas termudah untuk meng-
konfigurasi sistem operasi adalah
Mandrake Control Center (MCC)—
terdapat di layar desktop anda,
setelah anda login. Tampak pada
gambar adalah layar desktop
Linux Mandrake dengan MCC-
nya.

Tampilan Control Center
Klik ikon MCC maka akan tampil
Control Center tersebut. Fungsinya
mirip Control Panel di Windows.
Pada MCC, kita dapat menset
boot, hardware, network/Internet,
keamanan (security) dan sistem.
Dalam tulisan ini, hanya beberapa
hal yang akan dibahas.

1

7

2

Menyetel waktu
Jika anda perlu menyetel waktu,
silakan melakukannya di System
→ Date & Time.

Dilakukan tanpa MCC
Untuk setup LAN di jaringan ope-
rasi multi sistem, gunakan fasilitas
Network Neighbourhood. Fasilitas
ini di Linux dikenal sebagai
Samba. Setup dilakukan  lewat
Samba Web Administration Tool
(SWAT) di http://localhost:901
atau http://127.0.0.1:901.

Pilihan pada Bootloader
Pada Boot → Boot Config →
Configure, anda akan memperoleh
beberapa pilihan. Standar Linux
Mandrake akan menggunakan
‘LILO with graphical menu.’

10 11

5 Pilihan sistem operasi
Setelah di LILO di OK-kan, anda
akan memperoleh beberapa entry
pilihan sistem operasi pada saat
booting.  Anda bisa men-set, sistem
operasi default yang akan dijalan-
kan. Ini berlaku untuk Linux dan
Windows.

6

Sambungan ke Internet
Jika mengoperasikan Mandrake
sebagai Server dan aplikasi yang
agak aneh, coba lihat Webmin
untuk menset berbagai server.
Fasilitas Webmin dapat di akses
di https://localhost:10000 atau
https://127.0.0.1:10000.  Per-
hatikan, di sini digunakan https.

12



38 NeoTek Desember 2001

NeoTekno

Hacking perlu dilakukan dengan sistematis. Onno W. Purbo menyajikan
langkah-langkah awal yang perlu dilakukan dalam hacking.

EKNIK PALING AWAL
sekali yang harus
dilakukan oleh se-

orang hacker sebelum se-
rangan dilakukan adalah
melakukan proses foot-
printing atau, dalam bahasa
kerennya, intelijen awal
tentang segala sesuatu yang
berkaitan dengan target yang
dituju. Dengan cara ini seo-
rang penyerang akan mem-
peroleh profil atau postur
keamanan yang lengkap da-
ri organisasi atau jaringan
yang akan diserang.

Pada dasarnya ada empat
langkah utama yang biasa-
nya dilakukan untuk mela-
kukan intelijen awal untuk
melihat scope dan situasi
target sasaran. Langkah ini
dikenal sebagai footprinting,
yaitu

• Menentukan scope
aktivitas atau serangan

• Network enumeration
• Interogasi DNS (domain

name)
• Mengintai jaringan.

Menentukan scope
aktivitas atau serangan
Pada tahap pertama ini kita
perlu memperoleh sebanyak

mungkin informasi yang
berkaitan dengan lokasi,
anak perusahaan, berita mer-
ger atau akuisisi, nomor te-
lepon, contact person dan
alamat email, masalah pri-
vasi dan kebijakan keaman-
an yang diterapkan, link ke
berbagai situs Web lain yang
berhubungan. Cara yang
biasa dipakai ada cukup
banyak, misalnya, meng-
gunakan wget (Linux) atau
Teleport Pro dan meng-copy
atau me-mirror seluruh Web
untuk dianalisis. Lihat di
dekat kode-kode "<", "!" ,
"-" di file HTML untuk
informasi yang anda bu-
tuhkan. Coba monitoring
berbagai milis dan lihat
posting yang berasal dari
@target-anda.com.

Bagi sistem administrator
yang ingin melawan hal ini,
ada baiknya membaca-baca
RFC 2196 Site Security
Handbook yang bisa di-
download dari
www.ietf.org/rfc/rfc2196.txt.

Network enumeration
Network enumeration dila-
kukan untuk melihat do-
main yang digunakan oleh
sebuah organisasi. Seni

mencari informasi tersebut
cukup seru, terutama untuk
mengetahui domain yang
digunakan oleh sebuah
perusahaan, contoh-nya
Telkom. Mereka mengguna-
kan telkom.net.id, telkom.
co.id, telkom.go.id, telkom.
net. Hmm, bagaimana me-
ngetahui sekian banyak do-
main dan Point of Contact
(PoC)-nya? Biasanya kita
menggunakan software
‘whois’ untuk membuka
berbagai informasi yang
berkaitan dengan registrar,
organisasi, domain, network
dan point of contact. Soft-
ware whois biasanya ada di
Linux. Bahaya laten, jika
registrar domain tidak ber-
hati-hati bisa jadi terjadi
pencurian domain (domain
hijack) dengan cara menya-
ru sebagai point of contact
dan memindahkan domain
tersebut ke tangan orang
lain.

Interogasi domain name
Setelah kita mengetahui do-
main yang berkaitan dengan
organisasi sasaran, selanjut-
nya kita perlu mencek
hubungan alamat IP (IP
address) dan domain atau

hostname yang digunakan.
Cara paling sederhana ada-
lah melakukan interogasi
Domain Name System
(DNS). Beberapa software
yang biasanya digunakan
untuk melakukan interogasi
DNS tersedia secara mudah
di Linux, seperti ‘nslookup,’
‘dig,’ atau ‘host’ yang dapat
secara sepesifik mengintero-
gasi Name Server (NS),
Mail Exchanger (MX), Host
Info (HINFO) maupun
semua informasi yang ada
dengan parameter ANY.

Proses yang paling cepat
untuk memperoleh semua
informasi yang dibutuhkan
adalah dengan mengguna-
kan zone transfer di DNS.
Jika operator DNS-nya
tidak pandai, kita dapat
melakukan zone transfer
DNS dengan mudah
menggunakan perintah
"host -l -v -t any target-
domain.com".

Bagi para system administ-
rator, ada baiknya berhati-
hati dengan adanya ke-
mungkinan penyerang yang
akan menginterogasi DNS
anda. Setting zone transfer
ke secondary server atau

T

Intelijen Awal HackingIntelijen Awal Hacking
FFoot Printingoot Printing
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query DNS harus dibatasi
dan dijaga melalui xfernets
directive di named (BIND
8.0). Ada baiknya di-firewall
semua hubungan inbound
TCP pada port 53; hanya
hubungan UDP port 53
yang diizinkan.

Mengintai jaringan
Setelah mengetahui daftar
alamat IP (IP address) dari
berbagai host yang ada di
target anda. Langkah

selanjutnya adalah memeta-
kan topologi jaringan, baik
yang menuju ke target
sasaran maupun konfigurasi
internal jaringan target.
Biasanya kita mengunakan
software seperti traceroute
(Linux / UNIX) atau tracert
(Windows) untuk melaku-
kan pemetaan jaringan. Yang
paling seru adalah bagaima-
na melakukan traceroute
untuk menembus pertahan-

an firewall; kadang dapat di
tembus dengan mengirim-
kan paket traceroute pada
port UDP 53 (DNS query),
misalnya melalui perintah
traceroute -S -p53.

Bagi system administrator,
teknik Intrusion Detection
menjadi penting untuk di-
kuasai untuk menjaga ada-
nya penyerang yang masuk
dan melakukan pemetaan
jaringan internal kita. Salah

satu program Intrusion
Detection yang gratis dan
baik adalah www.snort.org
yang dibuat oleh Marty
Roesch.

Mudah-mudahan tulisan
sederhana ini, dapat mem-
berikan inspirasi bagi para
penyerang maupun para
sistem administrator dalam
menangkal intelejen yang
dilakukan para penyerang di
Internet.

Selain Internet Explorer (IE) sendiri yang dapat digunakan
untuk browsing secara offline, di Internet banyak tersedia
program yang dapat ‘membedol’ isi sebuah situs dan
memindahkannya ke harddisk di komputer anda beserta
link-linknya. Dengan bantuan program semacam ini, anda

dapat mengawali foot printing anda: ‘membajak’ isi sebuah
situs untuk anda amati dan analisis. Di bawah ini, diberikan
cara langkah demi langkah penggunaan sebuah offline
browser bernama WebCopier. Program ini gratis dan dapat
anda download dari situs Webmasterfree.

1 Download WebCopier (gratis,
1,7Mb) dari www.webmas-
terfree.com/webcopier.html.
Lalu instal di komputer anda.

2 Jalankan WebCopier. Klik ‘File’
→ ‘New.’ Muncul wizard
‘Create a New Project.’ Klik
‘Next’ untuk memulai projek.

3 4 Pada layar selanjutnya, pilih
‘Add the address by entering its
URL.’ Kembali, klik ‘Next.’

8 Sebuah jendela terbuka, mem-
perlihatkan WebCopier men-
download situs yang dituju.
Setelah selesai, klik ‘Close.’

Masukkan nama projek untuk
pembuatan mirror situs yang
akan anda teliti. Lalu klik ‘Next.’

Menggunakan WebCopier untuk membuat mirror sebuah situs di harddisk anda

5 Ketikkan alamat URL dari situs
untuk projek anda. 6 Tentukan tempat di hard disk

anda untuk menyimpan (save)
projek anda ini.

7 Pada langkah terakhir anda
dipersilakan men-save projek
dan mulai men-download. Lalu
klik tombol ‘Finish.’ 

9 Kini kembali ke jendela Web-
Copier. Lewat fungsi expand,
anda dapat melihat hasil
download-nya.

10 Jika anda mengklik nama pro-
jek di sisi kiri dua kali, maka
situs itu mulai ditayangkan di
komputer anda.

11 Kini situs itu beserta linknya
tersimpan di harddisk anda.
Buka IE, klik ‘File’ → ‘Open.’
Browse ke tempat penyim-
panan file situs.

12 IE menjalankan situs NeoTek,
dengan file yang disimpan di
harddisk.



Teknik Network Enumeration merupakan salah satu
langkah yang harus dilakukan dalam melakukan foot
printing, istilah kerennya intelijen awal sebelum melakukan
serangan. Dalam proses mengevaluasi network ini, kita
biasanya menggunakan perintah whois (yang tersedia di
Linux).

Tentunya kita harus tahu di mana lokasi server whois yang
memungkinkan kita memperoleh informasi yang kita
butuhkan. Bagi anda yang ingin melihat informasi host di
luar negeri bisa mencek berbagai server di

• www.allwhois.com
• whois.apnic.net
• hois.networksolutions.com
• whois.crsnic.net
• whois.internic.net.

Bagi anda yang ingin mengevaluasi host dalam domain *.id,
ada baiknya mencoba menggunakan mesin
whois.idnic.net.id, karena sebagian informasi whois domain
ID terdapat di mesin tersebut.

Domain Query
Dengan menggunakan “whois domain@whois. nicserver”
kita dapat memperoleh organisasi yang menggunakan
domain yang akan diserang. Sebagai contoh, di bawah ini
kita meminta informasi tentang domain telkom.co.id
melalui idnic.net.id.

[root@gate onno]# whois telkom.co.id@whois.idnic.net.id
[whois.idnic.net.id]
warning: 'rwhoisd' user id is unknown -- unable to change id
warning: running as root
%rwhois V-1.5:003fff:00 localhost (by Network Solutions, Inc. V-1.5.7)
domain:Class-Name:domain
domain:ID:telkom2-DOM-IDNIC
domain:Auth-Area:id
domain:Guardian;I:telkom2-GRD-IDNIC
domain:Domain-Name:telkom.co.id
domain:Primary-Server;I:ns1104-HST-IDNIC
domain:Secondary-Server;I:ns2128-HST-IDNIC
domain:Organization:PT TELEKOMUNIKASI INDONESIA, tbk
domain:Admin-Contact;I:epi1-IDNIC
domain:Tech-Contact;I:eph1-IDNIC
domain:Billing-Contact;I:epi1-IDNIC
domain:Created:19950518
domain:Updated:19980431
domain:Updated-By:hostmaster@idnic.net.id

%error 350 Invalid Query Syntax
%ok

Sebagai contoh tambahan, kita melakukan juga query
untuk domain telkom.net.id melalui whois.idnic.net.id.

[root@gate onno]# whois telkom.net.id@whois.idnic.net.id
[whois.idnic.net.id]
warning: 'rwhoisd' user id is unknown -- unable to change id
warning: running as root
%rwhois V-1.5:003fff:00 localhost (by Network Solutions, Inc. V-1.5.7)
domain:Class-Name:domain
domain:ID:telkom1-DOM-IDNIC
domain:Auth-Area:id
domain:Guardian;I:telkom1-GRD-IDNIC
domain:Domain-Name:telkom.net.id
domain:Primary-Server;I:ns136-HST-IDNIC

domain:Secondary-Server;I:ns2129-HST-IDNIC
domain:Secondary-Server;I:ns316-HST-IDNIC
domain:Organization:PT TELEKOMUNIKASI INDONESIA, tbk
domain:Admin-Contact;I:eph1-IDNIC
domain:Tech-Contact;I:is8-IDNIC
domain:Billing-Contact;I:de21-IDNIC
domain:Created:19960514
domain:Updated:20001009
domain:Updated-By:hostmaster@idnic.net.id

%error 350 Invalid Query Syntax
%ok

Kebanyakan berbagai informasi yang diperoleh masih beru-
pa kode-kode yang harus dievaluasi lebih lanjut mengguna-
kan perintah whois ke server whois yang sama. Tetapi jelas
bahwa organisasi yang menggunakan telkom.co.id dan
telkom.net.id adalah PT. Telekomunikasi Indonesia, Tbk.

Point of Contact Query
Ada dua contact person yang biasanya terdapat dalam
informasi whois, yaitu Administrator Contact dan Technical
Contact. Sayangnya, nama mereka biasanya tertulis dalam
kode kriptik. Untuk melihat siapa, nomor telepon, alamat
dsb dari contact person yang menguasai domain yang di-
maksud dapat dilakukan secara sederhana dengan mema-
sukkan nama kode atau handle dari contact person tersebut
ke server whois.

Sebagai contoh di bawah ini, kita melihat handle epi1-IDNIC
dan eph1-IDNIC yang menjadi kontak domain Telkom.

[root@gate onno]# whois epi1-IDNIC@whois.idnic.net.id
[whois.idnic.net.id]
warning: 'rwhoisd' user id is unknown -- unable to change id
warning: running as root
%rwhois V-1.5:003fff:00 localhost (by Network Solutions, Inc. V-1.5.7)
contact:Class-Name:contact
contact:ID:epi1-idnic
contact:Auth-Area:id
contact:Name:Epy Ponco Istiyono
contact:Email:ponco@telkom.net.id
contact:Type:I
contact:Phone:022-4523225
contact:Fax:022-4523232
contact:Organization;I:PT TELEKOMUNIKASI INDONESIA
contact:Occupation;I:Pj. Manager MONICE - DIVMEDIA
contact:Address;I:Jln Kebonsirih 37;JAKARTA;INDONESIA
contact:Created:951229
contact:Updated:980431
contact:Updated-By:hostmaster@idnic.net.id

%ok

[root@gate onno]# whois eph1-idnic@whois.idnic.net.id
[whois.idnic.net.id]
warning: 'rwhoisd' user id is unknown -- unable to change id
warning: running as root
%rwhois V-1.5:003fff:00 localhost (by Network Solutions, Inc. V-1.5.7)
contact:Class-Name:contact
contact:ID:eph1-idnic
contact:Auth-Area:id
contact:Name:Ery Punta Hendraswara
contact:Email:phunta@telkom.net.id
contact:Type:I
contact:Phone:021-5229248
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contact:Fax:021-5222296
contact:Organization;I:PT TELEKOMUNIKASI INDONESIA
contact:Occupation;I:Staff GNOC - DIVMEDIA
contact:Address;I:Jln Gatot Subroto no 52, Lantai 3;Jakarta;INDONESI
contact:Created:951229
contact:Updated:980431
contact:Updated-By:hostmaster@idnic.net.id

%ok

Kita lihat dengan jelas nama, alamat, jabatan, divisi internal
di Telkom, nomor telepon, email address dsb. Lumayan
lengkap untuk mengetahui secara pasti lokasi-lokasi
mereka.

Name Server Query
Yang akan sangat bermanfaat juga pada saat melakukan
network enumeration adalah melihat mesin mana saja yang
membawa informasi domain dari target sasaranan. Hal ini
dapat dilihat dari entry NS (Name Server). Biasanya ada
pada pada entry Primary-Server dan Secondary Server.
Untuk melihat lebih rinci, kode kriptik yang ada pada
informasi awal kita masukan kembali kepada server whois
untuk memperoleh informasi lebih lengkap.

Pada tampilan berikut diperlihatkan informasi tentang
name server yang membawa informasi telkom.co.id.

[root@gate onno]# whois ns1104-hst-idnic@whois.idnic.net.id
[whois.idnic.net.id]
warning: 'rwhoisd' user id is unknown -- unable to change id
warning: running as root
%rwhois V-1.5:003fff:00 localhost (by Network Solutions, Inc. V-1.5.7)
host:Class-Name:host

host:ID:ns1104-HST-IDNIC
host:Auth-Area:id
host:Host-Name:ns1.telkom.co.id.
host:IP-Address:202.134.0.155
host:Created:981104
host:Updated:981104
host:Updated-By:hostmaster@idnic.net.id

%ok

[root@gate onno]# whois ns2128-hst-idnic@whois.idnic.net.id
[whois.idnic.net.id]
warning: 'rwhoisd' user id is unknown -- unable to change id
warning: running as root
%rwhois V-1.5:003fff:00 localhost (by Network Solutions, Inc. V-1.5.7)
host:Class-Name:host
host:ID:ns2128-HST-IDNIC
host:Auth-Area:id
host:Host-Name:ns2.telkom.co.id.
host:IP-Address:202.134.2.5
host:Created:981104
host:Updated:981104
host:Updated-By:hostmaster@idnic.net.id

%ok

Informasi penting yang dapat ditarik di sini adalah nama
mesin dan IP address-nya. Hal ini sudah cukup untuk
melakukan evaluasi lebih lanjut tentang jaringan mereka.

Tentunya masih banyak yang bisa kita evaluasi dengan
menggunakan whois. Dengan informasi yang ada di tangan
sekarang, sudah cukup lumayan untuk melakukan
pemetaan jaringan dsb.
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Interogasi DInterogasi DNNS — Melihat Mesin di S — Melihat Mesin di DomainDomain SasarSasaranan
Sesudah melakukan network enumeration menggunakan
perintah “whois” langkah selanjutnya yang akan banyak
membantu mengidentifikasi semua domain yang berada di
bawah organisasi sasaran adalah dengan mengambil infor-
masi Domain Name System (DNS). DNS pada dasarnya
adalah sebuah basisdata yang terdistribusi yang melakukan
pemetaan antara alamat IP dengan nama domain dan
sebaliknya.

Jika DNS tidak dikonfigurasi dengan baik (aman), maka akan
sangat mungkin bagi orang lain untuk melihat informasi
tentang organisasi di dalamnya. Salah satu kesalahan paling
fatal yang sering dilakukan oleh sistem administrator
adalah mengizinkan pengguna Internet yang tidak bisa
dipercaya untuk melakukan zone transfer.

Zone transfer adalah fasilitas di DNS untuk mentransfer
seluruh informasi tentang domain yang akan menjadi
sasaran tembak. Jika anda berhasil memperoleh informasi
seluruh domain tersebut, beberapa informasi yang akan
membantu anda adalah entry:
• HINFO - yang memberikan informasi tentang mesin

yang digunakan.

• MX - mesin perantara yang menerima email untuk
domain tersebut.

Selain beberapa informasi lainnya tentang pemetaan alamat
IP dengan hostname.

Salah satu cara yang mungkin agak mudah untuk melaku-
kan zone transfer, pada masa lalu, bisa dilakukan dengan

mudah menggunakan perangkat lunak nslookup dengan
perintah ls. Hanya saja, nslookup yang ada pada saat ini
biasanya sudah tidak lagi dilengkapi dengan perintah ls,
karena sering disalahgunakan untuk melakukan zone
transfer yang diperlukan pada saat melalukan footprinting
sebelum serangan di lakukan.

Alternatif lain yang dapat digunakan adalah menggunakan
software dig dan host. Sebagai contoh, di bawah ini adalah
hasil interogasi DNS dari domain telkom.co.id dengan
mengunakan perintah host -l -v -t any.

[root@gate onno]# host -l -v -t any telkom.co.id
Trying "telkom.co.id."
;; ->>HEADER<<- opcode: QUERY, status: NOERROR, id: 40309
;; flags: qr rd ra; QUERY: 1, ANSWER: 6, AUTHORITY: 3, ADDITIONAL: 5

;; QUESTION SECTION:
;telkom.co.id. IN ANY

;; ANSWER SECTION:
telkom.co.id. 65237 IN MX 5 in-mta1.telkom.co.id.
telkom.co.id. 65237 IN MX 10 in-mta2.telkom.co.id.
telkom.co.id. 61859 IN A 202.134.2.15
telkom.co.id. 79371 IN NS ns3.telkom.co.id.
telkom.co.id. 79371 IN NS ns1.telkom.co.id.
telkom.co.id. 79371 IN NS ns2.telkom.co.id.

;; AUTHORITY SECTION:
telkom.co.id. 79371 IN NS ns3.telkom.co.id.



telkom.co.id. 9371 IN NS ns1.telkom.co.id.
telkom.co.id. 79371 IN NS ns2.telkom.co.id.

;; ADDITIONAL SECTION:
in-mta1.telkom.co.id. 65237 IN A 202.134.0.196
in-mta2.telkom.co.id. 65237 IN A 202.134.0.197
ns1.telkom.co.id. 79371 IN A 202.134.0.155
ns2.telkom.co.id. 79371 IN A 202.134.2.5
ns3.telkom.co.id. 79371 IN A 202.134.1.10

Received 270 bytes from 202.159.33.2#53 in 883 ms

Atau kalau anda ingin men-save hasil interogasi ke dalam
file agar memudahkan pengevaluasiannya di kemudian
hari, dapat di-redirect menggunakan perintah >
[root@gate onno]# host -l -v -t any telkom.co.id > zone_telkom.co.id

Kebetulan tidak banyak informasi yang dapat diperoleh dari
hasil query tentang telkom.co.id. Ada beberapa entry MX,
NS dan A yang diperoleh dari query DNS telkom.co.id.
Beberapa inti informasi tersebut adalah:

• MX berisi informasi tentang Mail Exchange, tempat
email dikirim ke domain tersebut.

• NS berisi informasi tentang mesin yang berfungsi
membawa semua informasi DNS domain telkom.co.id.

• A adalah alamat IP dari mesin yang dimaksud.

Dengan minimalnya informasi, paling tidak kita ketahui
bahwa:

• ada dua (2) mesin utama yang berfungsi sebagai MX
untuk domain telkom.co.id yaitu in-mta1.telkom.co.id &
in-mta2.telkom.co.id.

• tampaknya mesin-mesin utama telkom.co.id berada di
alamat IP keluarga 20.134.0.x.

• tampaknya keluarga 202.134.1.x & 202.134.2.x juga perlu
dievaluasi karena ada beberapa mesin penting di sana.

• tidak ada informasi HINFO, jadi kita tidak bisa melihat
secara langsung mesin atau sistem operasi apa yang
digunakan oleh Telkom.

Mungkin akan menarik jika kita scan atau petakan semua
mesin yang berada di alamat IP 202.134.0.x s/d 202.134.2.x
karena akan memperlihatkan semua mesin penting yang
akan mendukung kerja telkom.co.id termasuk anak-anak

perusahaannya; kemungkinan besar termasuk telkom.net.id,
plasa.com dll.

Jika kita ingin melihat alamat IP yang spesifik dapat juga
dilakukan menggunakan program host atau dig. Sebagai
contoh di sini diperlihatkan pada saat melakukan query
tentang www.telkom.co.id melalui perintah dig.

[root@gate onno]# dig www.telkom.co.id
; <<>> DiG 9.1.1 <<>> www.telkom.co.id
;; global options:  printcmd
;; Got answer:
;; ->>HEADER<<- opcode: QUERY, status: NOERROR, id: 36787
;; flags: qr rd ra; QUERY: 1, ANSWER: 1, AUTHORITY: 3, ADDITIONAL:
3

;; QUESTION SECTION:
;www.telkom.co.id. IN A

;; ANSWER SECTION:
www.telkom.co.id. 39899 IN A 202.134.2.15

;; AUTHORITY SECTION:
telkom.co.id. 79239 IN NS ns2.telkom.co.id.
telkom.co.id. 79239 IN NS ns3.telkom.co.id.
telkom.co.id. 79239 IN NS ns1.telkom.co.id.

;; ADDITIONAL SECTION:
ns1.telkom.co.id. 79239 IN A 202.134.0.155
ns2.telkom.co.id. 79239 IN A 202.134.2.5
ns3.telkom.co.id. 79239 IN A 202.134.1.10

;; Query time: 303 msec
;; SERVER: 202.159.33.2#53(202.159.33.2)
;; WHEN: Fri Aug 10 08:07:42 2001
;; MSG SIZE  rcvd: 152

Dari data ini diperoleh informasi bahwa www.telkom.co.id
berada dalam daerah alamat IP 202.134.2.x. Jadi betul pre-
diksi di atas bahwa mesin-mesin di daerah 202.134.0.x s/d
202.134.2.x akan membawa beberapa mesin penting untuk
operasional telkom.co.id dan berbagai anak perusahaan di
bawahnya.

Langkah keempat atau terakhir dalam proses footprinting
adalah melakukan pengintaian jaringan lawan, dalam baha-
sa Inggris-nya adalah network reconnaissance. Proses peng-
intaian dapat dilakukan dengan menggunakan perangkat
lunak traceroute (di UNIX/Linux), atau menggunakan
tracert (di Windows).

Traceroute merupakan perangkat lunak diagnostik yang
pertama kali di kembangkan oleh salah satu sesepuh
Internet yaitu Van Jacobson. Dengan mengakali parameter
Time To Live (TTL) di paket IP agar setiap router yang
dilewati mengirimkan berita ICMP_TIME_EXCEEDED,
kita dapat memetakan rute yang diambil oleh sebuah paket
dalam jaringan Internet.

Sebagai contoh kita akan melihat hasil traceroute ke bebera-
pa mesin yang ada di lingkungan jaringan Telkom, seperti
www.telkom.co.id, www.plasa.com, in-mta1.telkom.co.id.
Proses traceroute saya lakukan menggunakan sambungan
dial-up menggunakan ISP indo.net.id pada kecepatan
19.2Kbps karena kebetulan memang kabel telepon di rumah

saya tidak terlalu baik. Mari kita lihat beberapa kesimpulan
dari peta yang kita peroleh.

[root@gate onno]# traceroute www.plasa.com
traceroute to www.plasa.com (202.134.0.172), 30 hops max, 38 byte
packets
1  Digital-Tc.indo.net.id (202.159.33.29)  187.690 ms  189.692 ms

189.757 ms
2  Subnet-Gateway.indo.net.id (202.159.33.32)  189.820 ms  178.021

ms  179.822 ms
3  Loral-Gateway.indo.net.id (202.159.32.1)  189.840 ms  199.950 ms

182.850 ms 4  202.148.63.65 (202.148.63.65)  216.687 ms *  219.695
ms
5  * * 198.32.204.83 (198.32.204.83)  300.194 ms
6  * s2-4-gw1.gcc.jakarta.telkom.net.id (202.134.3.241)  490.050 ms

409.613 ms
7  * FE11-0-0.sm2.jakarta.telkom.net.id (202.134.3.149)  300.095 ms  

309.653 ms
8  GigaE5-0.1.emm.jakarta.telkom.net.id (202.134.3.174)  349.822 ms
299.629 ms *
9  www.plasa.com (202.134.0.136)  400.178 ms  389.508 ms *
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Tampaknya www.plasa.com berada di Jakarta, karena mela-
lui beberapa mesin atau router penting Telkom yang ada di
Jakarta; mesin gcc, sm2 kemungkinan ada di Semanggi atau
Sentral Telkom di Gatot Subroto. Yah, itu hanya tebakan
dari gaya penamaan mesin Telkom yang kemungkinan
mengambil referensi pola penamaan tempat cara TNI yang
agak kriptik tapi terprediksi Waktu yang dibutuhkan untuk
mengirimkan paket dan dikembalikan lagi oleh www.plasa.com
adalah sekitar 400 mili detik.

[root@gate onno]# traceroute in-mta1.telkom.co.id
traceroute to in-mta1.telkom.co.id (202.134.0.196), 30 hops max, 38
byte packets 1  Digital-Tc.indo.net.id (202.159.33.29)  507.252 ms
489.515 ms  509.857 ms
2  * Subnet-Gateway.indo.net.id (202.159.33.32)  200.130 ms

199.694 ms
3  Loral-Gateway.indo.net.id (202.159.32.1)  199.793 ms  189.703 ms

189.889 ms
4  202.148.63.65 (202.148.63.65)  389.829 ms  269.620 ms *
5  * * *
6  s2-4-gw1.gcc.jakarta.telkom.net.id (202.134.3.241)  869.655 ms

669.665 ms
559.793 ms
7  FE11-0-0.sm2.jakarta.telkom.net.id (202.134.3.149)  489.828 ms

419.716 ms *
8  GigaE5-0.1.emm.jakarta.telkom.net.id (202.134.3.174)  369.912 ms

219.670 ms  219.859 ms
9  in-mta2.plasa.com (202.134.0.196)  339.852 ms  239.796 ms

289.778 ms

Secara tidak sengaja kita bisa melihat ternyata in-mta1.
telkom.co.id adalah juga in-mta2.plasa.com. Artinya semua
mail ke orang telkom dengan hostname telkom.co.id akan
bisa ditangkap di in-mta2.plasa.com juga. Ini agak berbaha-
ya sebetulnya untuk sebuah perusahaan seperti Telkom.
Tampaknya in-mta2.plasa.com, in-mta1.telkom.co.id dan
www.plasa.com berada dalam sebuah keluarga jaringan
202.134.0.x. Jika kita mengetahui struktur organisasi Tel-
kom, berarti 202.134.0.x merupakan tempat penyimpanan
mesin-mesin yang dikelola oleh Divisi Multimedia yang
mengelola plasa.com.

[root@gate onno]# traceroute www.telkom.net.id
traceroute to www.telkom.net.id (202.134.0.12), 30 hops max, 38 byte
packets
1  Digital-Tc.indo.net.id (202.159.33.29)  197.334 ms  189.571 ms

189.805 ms
2  Subnet-Gateway.indo.net.id (202.159.33.32)  199.799 ms  189.752

ms  189.969
ms
3  Loral-Gateway.indo.net.id (202.159.32.1)  189.734 ms  199.678 ms

189.795 ms
4  202.148.63.65 (202.148.63.65)  249.844 ms  316.807 ms  289.855

ms
5  * * *
6  * s2-4-gw1.gcc.jakarta.telkom.net.id (202.134.3.241)  260.189 ms

299.710 ms
7 * FE11-0-0.sm2.jakarta.telkom.net.id (202.134.3.149)  320.187 ms

319.636 ms
8  * GigaE5-0.1.emm.jakarta.telkom.net.id (202.134.3.174)  330.246

ms *
9  game.plasa.com (202.134.0.12)  460.078 ms *  420.131 ms

Ah, semakin yakin saja kita, dari hasil traceroute www.
telkom.net.id terlihat sekali bahwa ternyata www.telkom.
net.id identik dengan game.plasa.com. Jelas bahwa semua
keluarga besar plasa.com dan telkom.net.id adalah servis
TelkomNet yang merupakan bagian dari servis Divisi
Multimedia PT. Telkom; termasuk tentunya TelkomNet

Instant yang sering menjadi bulan-bulanan ISP Indonesia
yang lain karena layanan itu menunjukkan ketidakadilan
(ketidak-fair-an) Telkom dalam memberikan servis.
Menarik untuk di simak ternyata Divisi Multimedia meme-
gang keluarga IP 202.134.0.x sangat predictable karena logi-
kanya 202.134.x.x kemungkinan besar adalah keluarga IP-
nya PT. Telkom, dan nomor terkecil (0) di ambil oleh pe-
nyelenggara atau operatornya, yaitu Divisi Multimedia.
Dari hasil traceroute juga terlihat bahwa jaringan backbone
atau router utama Telkom tampaknya menggunakan ke-
luarga IP 202.134.3.x.
Selanjutnya kita mencoba melihat bagaimana kantor pusat
PT. Telkom Indonesia di Bandung. Mari kita lihat hasil
traceroute ke www.telkom.co.id yang tampaknya berada di
kantor pusat PT. Telkom di Bandung.

[root@gate onno]# traceroute www.telkom.co.id
traceroute to www.telkom.co.id (202.134.2.15), 30 hops max, 38 byte
packets
1  Digital-Tc.indo.net.id (202.159.33.29)  341.254 ms  189.285 ms

189.863 ms
2  Subnet-Gateway.indo.net.id (202.159.33.32)  389.814 ms  539.738

ms  339.843 ms
3  Loral-Gateway.indo.net.id (202.159.32.1)  379.842 ms  189.737 ms

629.806 ms
4  * * *
5  198.32.204.83 (198.32.204.83)  520.177 ms  529.823 ms  489.612 ms
6  * * s2-4-gw1.gcc.jakarta.telkom.net.id (202.134.3.241)  490.196 ms
7  * FE11-0-0.sm2.jakarta.telkom.net.id (202.134.3.149)  720.213 ms *
8  * * *
9  * * fe-sm2.jakarta.telkom.net.id (202.134.3.179)  599.379 ms

10  s0-lembong.bandung.telkom.net.id (202.134.3.38)  719.669 ms
659.553 ms S4.lbg.bandung.telkom.net.id (202.134.3.50)  529.925 ms
11  192.168.16.250 (192.168.16.250)  765.193 ms  859.890 ms *
12  202.134.2.15 (202.134.2.15)  1070.083 ms  769.732 ms *

Dari hasil traceroute ke www.telkom.co.id ada yang meng-
gelitik hati saya, ternyata ada router di IntraNet Telkom
menggunakan IP 192.168.16.250 yang tampak ke jaringan
publik. Ini terus terang, agak menyalahi pakem untuk
pendesainan jaringan yang baik. Router yang menjadi
firewall ke jaringan IntraNet telkom tampaknya ber-alamat
di IP 202.134.3.50.
Biasanya jaringan IntraNet 192.168.x.x & 10.x.x.x, harus-
nya tertutup untuk dilihat oleh publik. Jika perancang ja-
ringan tersebut secara benar merancang jaringannya, orang
akan sangat sulit melakukan penetrasi jaringan dengan
menggunakan traceroute. Salah satu cara untuk melakukan
traceroute menembus IntraNet, adalah dengan melakukan
traceroute pada port tertentu, misalnya port 53 yang meru-
pakan port Domain Name System (DNS) dengan
menggunakan perintah:
# traceroute -s -P53 IP_mesin_tujuan_dibalik_firewall

Para administrator jaringan, tentu akan sakit hati jika
jaringannya diintai para hacker menggunakan traceroute.
Ada beberapa software yang dapat digunakan untuk
menipu atau membatasi proses pengintaian tersebut, seperti
snort (www.snort.org) yang merupakan software untuk
melakukan Network Intrusion Detection System (NIDS).
Kalau mau lebih jail lagi mungkin bisa menggunakan
RotoRouter (http://packetstorm.securify.com/linux/
trinux/src/rr-1.0.tgz) yang dapat mengirimkan respons
palsu terhadap program yang melakukan tracreroute. Selain
itu, anda juga dapat membatasi router-router yang ada di
luar jaringan untuk membatasi trafik ICMP dan UDP ke
sistem yang spesifik, yang akhirnya akan mengurangi
keterbukaan jaringan anda ke luar. NNTT
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3 MEMILIH BAHASA
Untuk memudahkan pengaturan
dan pengoperasian program ini,
klik ‘View’ > ‘Language’ dan pilih
‘Indonesian.’ Maka seluruh teks
pada interface FlashGet pun
berubah menjadi bahasa
Indonesia.

NeoSearch

rogram download accelerator
makin banyak kita jumpai. Pada
NeoTek Vol. I, No. 7, April 2001,

telah dibahas cara penggunaan Go!zilla,
sebuah program download accelerator
yang banyak digunakan orang dewasa
ini. Selain itu dapat dijumpai pula
program sejenis bernama Getright dan
Download Accelerator Plus.

Kini muncul lagi sebuah program
download accelerator yang langsung
meroket yaitu FlashGet, sebuah program
download yang unik. Jika sekarang ini
anda harus menunggu ‘berabad-abad’
dalam mendownload karena koneksi
yang lambat atau karena proses down-

FFLLAASSHHGGEETT
MMEENNYYIINNGGKKAAT WT WAKTAKTUU
DDOOWWNNLLOOADAD
FlashGet adalah program download accelerator yang
bekerja dengan membagi file yang di-download menjadi
beberapa bagian sehingga mempercepat waktu download.

P

MULAI MEN-DOWNLOAD
Sekarang coba download satu file
dari Internet. Saat file itu akan di-
download, muncul layar download
FlashGet. Di sini anda ditanya akan
membagi file menjadi berapa
bagian. Kita membagi file menjadi 5.

PEMBAGIAN FILE
Setelah anda mengklik ‘OK,’ file
langsung dibagi menjadi 5 bagian
dan di-download dengan nama
file sementara Jet#. Kelima ba-
gian file itu didownload secara
bersamaan dengan kecepatan
sama.

DAPATKAN FLASHGET
Buka browser anda dan ketik
www.amazesoft.com. Selan-
jutnya klik link ‘Download.’ Lalu
pilih file ‘Setup FlashGet’ versi
terbaru dan klik download.
Simpan (save) file itu di tempat
yang anda inginkan.

MENGINSTAL FLASHGET
Lakukan instalasi dengan
mengklik dua kali file ‘Setup’
yang anda download. Ikuti
langkah-langkah dalam instalasi.
Setelah selesai proses instalasi,
jalankan program FlashGet.

1
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Menghemat pulsa saat men-download

KETERANGAN CHART/LOG
Untuk melihat keterangan setiap
bagian file, anda dapat mengklik
bagian file di sisi kiri. Muncul
keterangan di sisi kanan layar yang
menjelaskan besar setiap file dan
sumbernya beserta kecepatannya.

9
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load yang terputus-putus, FlashGet
mungkin bisa menjadi jalan keluar
untuk anda.

FlashGet bekerja dengan membagi
file yang di-download menjadi bebe-
rapa bagian dan setiap bagian di-
download secara bersamaan. Hasil-
nya, kecepatan download meningkat
100% sampai dengan 500%.

Peningkatan kecepatan ini terjadi
karena FlashGet membuat koneksi
ganda (multiple connection) untuk
masing-masing file sehingga
bandwith yang tersedia dapat
dimanfaatkan sebaik mungkin.
Keistimewaan lain dari program ini

terletak pada manajemen download-
nya. FlashGet dapat membuat
kategori dalam jumlah tidak terbatas
untuk file anda. Pekerjaan download
dapat ditempatkan pada kategori
tertentu agar dapat diakses dengan
mudah dan cepat. Fitur manajemen
download yang mudah digunakan ini
akan membantu anda mengontrol
proses download. Program yang
dijagokan oleh PCMagazine ini juga
mendukung 20 bahasa untuk
interface-nya, termasuk bahasa
Indonesia!

DOWNLOAD SELESAI
Ketika proses download telah
selesai, klik bagian kategori tem-
pat anda menyimpan file terse-
but dan lihat infor hasil
download anda.

HASIL DOWNLOAD
File yang sudah anda download
secara otomatis akan disatukan
kembali oleh FlashGet dan di-
simpan pada direktori yang telah
ditetapkan. Anda kini dapat
menjalankna file hasil download
itu.

MENGATUR PILIHAN
Pada menu ‘Alat-alat’, klik ‘Pilih-
an-pilihan’ dan klik ‘Protocol.’ Di
sini anda dapat menentukan
FlashGet berkolaborasi dengan
browser yang disediakan atau
anda menentukan sendiri (user
define.)

MEMBUAT KATEGORI BARU
FlashGet memberikan kategori
default seperti terlihat pada
gambar, namun anda dapat
membuat kategori baru yang
sesuai dengan keinginan anda.
Klik ‘Kategori’ > ’Kategori Baru’
dan buat kategori anda.

4
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5 MENGATUR PROPERTI
Untuk mengatur kategori anda, klik
‘Properti Download Semula’ atau
tekan tombol ‘Alt+Ctrl+O.’ Di sini
anda dapat mengatur akan disim-
pan (save) di mana setiap file yang
masuk ke kategori.

6

FTP ATAU HTTP
Pada FlashGet disediakan pula
eksplorer FTP dan HTTP.
Fungsinya seperti Windows
Explorer. Anda dapat melihat isi
suatu server di Internet. Namun
jangan harap anda dapat
melakukan ‘pencurian’ pada
server tersebut.

12

HINT & TIPS • HINT & TIPS  • HINT  

Jumlah Pembagian File
Ada baiknya anda tidak men-
split file lebih dari 10 bagian
agar proses penyatuannya
kembali tidak mengalami
kesulitan.

!

Koneksi
Untuk mengoptimalkan
kecepatan download, gunakan
alt+L atau klik alat-alat dan
pilih ‘Mematuhi kecepatan
download.’

!
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pakah anda pernah ‘mencici-
pi’ kemudahan berbagi file-
file MP3 lewat program

yang kontroversial bernama Naps-
ter? Jika ya, berarti anda pernah mem-
praktikkan teknologi bernama Peer 2
Peer atau lebih dikenal dengan sing-
katan P2P. Teknologi ini jadi mewa-
bah setelah Napster memperkenalkan
cara yang mudah bagi para netter un-
tuk bertukar-tukar file lewat Internet.
Walaupun Napster akhirnya dilarang
memberikan layanan tersebut, ‘spirit’
yang juga menjadi semangat dasar
Internet—kebebasan pertukaran in-
formasi—telah kepalang merasuki
para netter. Maka, seperti sudah

MMOORRPPHHEEUUSS
MMEENNCCARARI & BI & BEERRBBAAGGII

FFIILE LELE LEWWAAT IT INNTTEERRNNEETT

Meskipun Napster telah ditelikung oleh industri rekaman,
semangat file sharing tidak menjadi kendur. Salah satu program
yang banyak digunakan orang adalah MMoorrpphheeuuss.

A

Men-download Morpheus
Buka browser anda dan ketikkan
www.musiccity.com. Setelah layar
terbuka maka akan ada tampilan la-
yar utama pada situs tersebut. Klik
download Morpheus untuk menda-
patkan file instalasi program
Morpheus. Save d tempat anda ingin
menyimpannya.

1
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Berbagi file dengan P2P’ers

3

9

Menginstal Morpheus
Setelah men-download file instalasi
Morpheus, jalankan file tersebut dan
ikuti perintah yang diberikan sampai
selesai. Setelah proses penginstallan
selesai, klik dua kali ikon yang ada
pada desktop anda.

Mengisi formulir
Saat pertama kali memulai program
ini, anda akan diminta untuk mendaf-
tarkan username anda dan password
beserta alamat email anda untuk login
key. Setelah mengisi semua field, klik
‘Next,’ bila username anda telah
dimiliki oleh user lain masukkan
username alternatif.

Men-download file
Bila sudah menemukan file yang an-
da inginkan, klik tombol kanan mouse
pada file tersebut dan pilih ‘Down-
load.’ Lewat Morpheus anda dapat
melanjutkan proses download di ke-
mudian hari, klik tombol kanan mouse
pada file yang sedang di-download
dan pilih ‘Resume download.’

Menyaksikan hasil download
File berjenis audio atau video yang
sedang anda download dapat anda
dengarkan atau saksikan walaupun
proses download belum selesai.
Untuk itu, ikon ‘Play’ pada sisi kanan
bawah. Bila proses download telah
selesai, anda dapat menyaksikan file
video anda lewat MyTheatre.

Menambah hasil pencarian
Anda dapat menaikkan kapasitas jum-
lah pencarian file yang anda cari.
Untuk itu, klik ‘Tools’ >  ‘Option’ dan
pilih ‘Advanced’ pada ‘Maximum
number of search results.’ Masukkan
angka maksimal yaitu 100, kemudian
klik  ‘OK.’
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dibahas pada NeoTek Vol. I, No. 2,
November 2000, program-program
file sharing atau P2P pun merebak
bertebaran di dunia maya. Sesuai
namanya, program sejenis ini me-
mudahkan kita mencari file yang
kita perlukan dan disediakan oleh
netter lain di komputernya sendiri.

Salah satu program P2P yang sedang
populer adalah Morpheus buatan
MusicCity.com. Software ini men-
duduki peringkat pertama dalam
deretan software P2P dan membuat
orang mulai melupakan Napster.
Tentu saja karena keunggulannya-
lah yang membuat Morpehus dige-

mari para Netter. Selain menyedia-
kan banyak fitur, software ini dapat
mencari file bukan hanya terfokus
pada satu ektensi file melainkan se-
mua jenis file. Artinya, selain  MP3,
program ini pun dapat menemukan
file audio lain, file video, file .exe,
file grafik. Pokoknya semua file!

4
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5

P2P atau Peer 2 Peer
adalah sistem jaringan yang memungkinkan
kita mencari file yang kita inginkan dalam
sebuah jaringan atau komunitas.

DDAFAFTTARAR
IISSTTIILLAHAH

HINT & TIPS • HINT & TIPS  • HINT  

File Sharing
Berhati-hatilah dengan file
yang anda share-kan, jangan
sampai file penting atau
rahasia anda dapat diambil
netter lain.

!

Bandwith
Agar anda dapat men-
download lebih cepat, pilihlah
user dengan saluran bandwith
yang besar.

!

6
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Mulai menggunakan Morpheus
Setelah anda berhasil login, Mor-
pheus akan menghubungkan anda
dengan server MusicCity secara
otomatis. Dan anda akan masuk ke
situs MusicCity. Untuk mengatur file
sharing anda, klik ikon MyMedia.

File sharing lewat Morpheus
Saat anda pertama kali membuka
Morpheus, secara otomatis seluruh
file yang ada pada harddisk anda
ditampung ke dalam folder MyMedia
untuk di-share oleh Morpheus. Untuk
menghentikan file sharing klik tombol
kanan mouse pada file tersebut dan
pilih ‘Stop sharing.’

Menggunakan search engine
Pada Morpheus disediakan fasilitas
search engine. Anda dapat mencari
file berdasarkan kategori (Audio,
Video, Image, Documents dan
Software) atau anda bisa mencari
seluruhnya (Everything). Cari file
dengan menggunakan tanda kutip
untuk pencarian yang akurat.

Menyaring hasil pencarian
Untuk mencegah pencarian file yang
offensive, anda dapat menyaring file
yang tidak perlu. Klik ‘Tools’ > ‘Op-
tion.’ Pilih ‘Filter,’ (No Filter, Offensive
Adult Content, Adult Content atau
Images or Videos) Bisa juga anda
pilih ‘Filter bogus music and video
files.’ Klik Ok.

Mengundang sahabat anda
Anda dapat mengundang teman
anda untuk bergabung di MusicCity.
Pada menu ‘Start’, pilih link ‘Invite A
Friend’ lalu masukkan alamat email
teman anda dan klik ‘Invite.’

Mengobrol di Morpheus
Morpheus juga menyediakan fasilitas
chat. Untuk mengaktifkannya, pada
menu ‘Start’ pilih link ‘Chat.’ Setelah
terbuka layar chat, klik ‘Load applied.’
Setelah itu anda akan dimasukkan ke
chat room. Anda dapat mengubah
nickname anda dan berpindah
ruangan obrolan.
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3 Membuka Copernic
Setelah selesai diinstal, Copernic
dapat dibuka dengan mengklik
tombol ‘Start’ > ‘Programs’ >
‘Copernic 2001 Basic.’

NeoSearch

anyak orang sudah mengetahui
cara mencari informasi lewat me-
sin pencari (search engine.) Dan

biasanya itu dilakukan lewat satu mesin
pencari, semisal Google atau Yahoo.
Apakah pernah terbayangkan hasil yang
akan anda dapat jika, alih-alih mengguna-
kan satu mesin pencari, anda memanfaat-
kan puluhan mesin pencari sekaligus?

Copernic Technologies Inc. menyediakan
sebuah perangkat lunak gratis yang me-
mungkinkan anda melakukan pencarian
informasi di Internet dengan memanfaat-
kan 80 mesin pencari lewat satu interface.
Program itu bernama Copernic 2001.

Versi gratis dari program ini bernama

MMOONNSSTTEER R 
MMEESSIIN PN PEENNCCARARII
COCOPPEERRNNIIC 200C 20011
Copernic bisa berlaku bagai monster lahap. Delapan puluh
mesin pencari (search engine) direngkuhnya sekaligus
untuk membantu anda mencari informasi di Internet. Jika
anda tidak ingin repot berpindah-pindah search engine,
program ini bisa menjadi jawabannya.

B

Mengunjungi situs
Jika anda ingin mengunjungi situs
yang ditemukan, anda dapat lang-
sung mengklik alamat situs (URL)
yang ada pada kolom ‘Address.’
Copernic akan mengantarkan anda
ke situs tersebut dengan membuka
sebuah jendela (window) baru.

Situs resmi Harry Potter
Copernic membuka browser
tersendiri dan menyajikan situs
yang anda pilih. Diperlihatkan
bahwa situs yang dibuka ini
adalah situs ketiga hasil pencarian
Copernic dari 96 yang ditemukan.

Download Copernic 2001
Anda dapat men-download gratis
Copernic 2001Basic dari situsnya
di www.copernic.com.  Jika anda
tidak ingin men-download
sendiri, file instalasi Copernic itu
(2,49 Mb) bisa anda dapatkan di
CD NeoTek yang dijual terpisah
dari majalah NeoTek.

Proses instalasi
Setelah proses instalasi selesai,
instal program ini dengan meng-
klik dua kali file instalasinya. Sela-
ma proses instalasi berlangsung,
akan ada beberapa pertanyaan
yang harus anda jawab dengan
mengklik radio button.

1
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Menggunakan ‘monster’ dalam pencarian informasi

Menyaring temuan
Anda masih bisa menyaring hasil
temuan dengan menekan tombol
‘Refine’ pada jendela program
Copernic. Setelah proses berlang-
sung, Copernic berhasil menjaring
55 dokumen yang sesuai dengan
kata kunci dari 96 hasil semula.

9
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Copernic 2001 Basic. Anda dapat
men-download-nya dari situs
Copernic.

Hal baru yang ditawarkan Copernic
2001—dan belum ditemukan pada
fitur-fitur yang ada di mesin pencari
dan browser yang ada sekarang ini—
adalah kemungkinan anda melakukan
penyaringan (fitur ‘Refine’) sehingga
anda tidak perlu repot-repot ‘tersasar’
ke situs-situs yang sudah tidak dapat
dijumpai atau tidak aktif (broken
link.) Selain itu, anda pun dapat
memutakhirkan hasil temuan dengan
menggunakan fitur ‘Update’ pada
Copernic 2001.

Men-download temuan
Jika anda ingin mem-browse
hasil temuan secara offline, anda
perlu menyimpan hasil temuan
di hard disk anda. Untuk itu,
lakukan download dengan
menekan tombol ‘Download.’

Mengeskpor temuan
Anda ingin mempunyai rekaman
temuan dalam bentuk file? Eks-
por temuan itu! Klik menu ‘File’
> ‘Export.’ File dapat disimpan
(save) dalam format Text, HTML,
XML, atau dBase.

Tampilan pertama
Inilah tampilan pertama Copernic
dan kami langsung coba mencari
informasi dengan keyword ‘harry
potter.’ Setelah mengetikkan
keyword, tekan ‘Enter.’ Copernic
pun langsung melakukan
pencarian di 80 search engine.

Proses pencarian
Window ‘Search Progress’ muncul
menunjukkan mesin pencari
(search engine) mana saja yang
digunakan Copernic untuk
mencari informasi dengan kata
kunci yang dimasukkan.

4
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5 Hasil pencarian
Dan inilah hasil pencarian Coper-
nic. Kata kunci yang ditemukan di
Web diberi tanda kuning. Ditunjuk-
kan di sini berapa situs Web yang
mempunyai info dengan kata kunci
yang dicari, alamat situsnya, score-
nya, dan mesin pencarinya.

6

Mengirim temuan
Temuan dapat anda kirim ke
teman anda lewat email. Pilih
satu atau beberapa temuan, lalu
klik menu ‘File’ > ‘Send.’ Temuan
dapat dikirim dalam format HTML
atau Text.

12

• Jika anda bosan dengan penampilan
Copernic 2001 yang ‘itu-itu saja,’ download

skin-nya lewat wwwwww..ccooppeerrnniicc
..ccoomm//pprroodduuccttss//ccooppeerrnniicc//bbaassiicc//iinnddeexx..hhttmmll,

maka Copernic pun otomatis akan berganti
‘kulit’ sehingga mempunyai tampilan baru.


